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Copyright
Copyright © 2017 Stratasys Ltd. All rights reserved.

This documentation contains proprietary information of Stratasys Ltd. This information is supplied solely to assist authorized
users of Stratasys J750 3D printing systems. No part of this document may be used for other purposes.

The specifications on which this document is based are subject to change without notice.

Trademarks

Stratasys, Objet, FullCure, PolyJet, J750, Connex, PolyJet Studio, GrabCAD Print, GrabCAD PolyJet Server are trademarks of
Stratasys Ltd. and/or its subsidiaries or affiliates and may be registered in certain jurisdictions. All other product names and
trademarks are the property of their respective owners..

FCC Compliance

The equipment referred to in this guide has been tested and found to comply with the limits for a Class A device pursuant to
part 15 of the FCC rules. These limits provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. Stratasys 3D printing systems generate, use and can radiate radio-frequency energy
and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-DUPCAB.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification to this equipment.
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it must be sent to appropriate
Pa facilities for recovery and recycling. For information about proper disposal, check your purchase contract, or contact the
supplier of the equipment.

Limitation of Liability

The product, software or services are being provided on an “as is” and “as available” basis. Except as may be stated
specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any kind, whether express or implied,
including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose and non-infringement.

Y ou understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental, special, consequential or
exemplary damages, including but not limited to, damages for loss of profits, goodwill, use, data or other intangible losses (even
if Stratasys has been advised of the possibility of such damages), resulting from: (i) the use or the inability to use the product or
software; (ii) the cost of procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software or data; (iv) statements
or conduct of any third party; (v) any other matter relating to the product, software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they are based are subject to
change. Stratasys Ltd. may, at any time and without notice, make changes to this document. Stratasys Ltd., for itself and on
behalf of its subsidiaries, assumes no liability for technical or editorial errors or omissions made herein, and shall not be liable
for incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration of data,
delays, or lost profits or savings arising from the use of this document.
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Stratasys J750 User Guide 1 About This Guide

Using This Guide

This user guide provides instructions for installing, operating and maintaining
J750 3D printing systems. It explains how to use features, and provides
practical examples to guide you as you use the system.

The text and figures in this guide are based on the J750 3D printer, printer
software version 85.1.0 and PolyJet Studio software version 10.8.10.

This guide assumes that—

« all the hardware, software, and network components of your J750 system
are installed, configured, and operating correctly.

« the operator has a working knowledge of the Windows® PC platform.

For More Information

DOC-08040 Rev. A

Visit www.stratasys.com to download additional documents for this printer,
including documents in other languages. Also available on this site: details
about consumables and support contacts.

If you have any questions or comments about the way information is
presented in this document, or if you have any suggestions for future editions,
please send a message to c-support@stratasys.com.
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Terms Used in This Guide

Build tray

Cleaning fluid

Client/user workstation

Connex™

Digital Material

Digital Material Mode

GrabCAD Print
Manager™
Mixed part
Mixed tray

Model material
PolyJet Studio™

OBJTF

OBJZF

Printer computer

Printer interface

Printer software

DOC-08040 Rev. A

In the print preparation application: The surface displayed on
the screen that represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing material feed tubes and the printing block,
used to completely remove Model and Support material from
the system before loading another type of material in the
printer and before long-term shutdown. The cleaning fluid is
supplied in standard material cartridges.

The workstation on which software is installed for preparing
build trays for production on PolyJet printers. (There is no limit
to the number of client workstations.)

The technology of printing models by jetting multiple materials
simultaneously from the print heads. This technology enables
J750 printers to print in Digital Material mode.

Combinations of model materials fabricated in the printer from
the basic model materials installed.

The printer mode used to print a job using two different model
materials. (This mode can also be used to eliminate the need for
performing the Material Replacement procedure when printing
with a single model material.)

A software application for preparing print jobs on a variety of
3D printers, including the Stratasys J750 printer.

The part of PolyJet Studio software that manages production
jobs before they are sent to the PolyJet printer.

Models whose parts are printed using more than one model
material.

A build tray containing objects, each of which is designed to be
printed using a different model material.

Material used for building models.

A software application that prepares files for printing on
Stratasys PolyJet printers.

The extension of a file that contains all of the information
needed for a model-printing job on PolyJet 3D printers. An
objtf file is used by PolyJet Studio to send a print job to a
PolyJet 3D printer.

The extension of a compressed “wrapper” file containing all of
the files used in an PolyJet Studio build tray. Using objzf files, a
printing job can be saved as a single file, for convenient storage
and transfer.

The computer inside the J750 printer that operates it.

The GUI (graphical user interface) used for controlling the
J750 printer.

Software running on the computer inside the J750 printer, that
controls all printer operations.
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Resin

STL

Support material

DOC-08040 Rev. A

The base substance from which photopolymer printing
materials are made for use in Stratasys PolyJet printers. In
PolyJet Studio and printer-application screens, “resin” refers to
cartridges of model and support materials.

A file used for printing 3D models.

Material used for supporting the structure of models during
production.
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Stratasys J750 User Guide 2 Safety

Safety Features

Stratasys 3D printers are designed to comply with CE and FCC
standards. They are equipped with the following safety features:

Cover Interlock Switch The power supplied to the UV lamp(s), the tray heater and the
motion motors is turned off when the cover is opened.

& Warning

Do not defeat (override) the interlock switch. Doing so could
result in serious personal injury. If the interlock switch does not
function correctly, do not use the printer, and contact your service
provider.

Safety Lock The cover is locked while the printer is working. If you do
manage to lift it, the UV lamps and the motion motors turn off.

Warning

Do not defeat (override) the safety lock. Doing so could result
in serious personal injury. If the safety lock does not function
correctly, do not use the printer, and contact your service provider.

The transparent section of the cover blocks harmful UV
radiation, allowing the operator to view the model as it is being
made.

UV Screening

uv
screen

Figure 2-1 Front view of the Stratasys J750 printer

The power to the printer is turned off in case of electrical
overcurrent.

Circuit Breaker

Note: The circuit breaker is only accessible to service
personnel.
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Stratasys J750 User Guide 2 Safety

UV-Lamp Overheating The power supplied to the UV lamp and the motion motors is

Protection turned off if the temperature around the lamp reaches 90°C
(194°F). A label on the UV-lamp cover indicates if the
temperature has exceeded 65°C (150°F).

Grounded Chassis The chassis of the printer is grounded, to prevent electrical
shock.

Note: The power outlet must be properly grounded, in
accordance with the local electric code, to provide this
protection.

If the J750 3D printing system is not used as specified in this guide, the safety
features may not provide adequate protection.

Symbols and Warning Labels

This following table lists the warning labels located on or in J750 printers.

Warning Symbol Meaning Location Comments

Hazard (general) | Onthe name plate on the | Read the instructions in
back of the printer. this document before
operating the printer.

Hot surface On the print block. Risk of burns. Do not
touch this surface after
printing.

High voltage Near the UV lamp Risk of electric shock.

connectors.

Near the power-supply
enclosures.

Ultraviolet Near the UV lamps. Risk of injury from
radiation ultraviolet radiation.

DOC-08040 Rev. A 2-3
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Safety Guidelines

Printer
Installation

Printer
Operation
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The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the system. If the system is not operated as specified,
the user's safety may be compromised.

>

\l

Y V. VvV V¥

Installation and removal of the printer should only be done by qualified
service personnel.

Connect the printer (and the UPS unit) to the electric outlet using a power
cord that is safety-certified.

The electric outlet should be easily accessible, near the printer.

Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose the
operator to serious danger from electric shock.

The following safety statement is followed by translations to Finish,
Norwegian, Swedish and Danish, as required by local regulations:

“The machine must be connected to a grounded power outlet.”

O FI: Laite on liitettdva suojakoskettimilla varustettuun pistorasiaan.

O NO: Apparatet ma tilkoples jordet stikkontakt.

O SE: Apparaten skall anslutas till jordat uttag.

O DK: Apparatets stikprop skal tilsluttes en stikkontakt med jord, som
giver forbindelse til stikproppens jord.

Leave a minimum of 15 centimeters between ventilation openings and
walls or other objects.

The printer should only be operated by persons trained by a Stratasys
customer-support representative.

All persons operating or maintaining the printer should know the location
of first aid and emergency equipment and how to use it. Never block
access to this equipment.

Keep fingers and other body parts clear of the printer cover when closing
it.

Never attempt to open the printer cover while it is working.
Never override the interlock safety switch.
If the interlock safety switch ever fails, do not use the printer.

Several parts of the printer remain extremely hot even after it has stopped
operating. Avoid touching the UV lamps and the print block.
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UV Radiation  The UV lamps used in the printer emit dangerous radiation.

> If the UV lamps remain on when the printer is open, do not stare directly
at the UV light. Shut down the printer and call your Stratasys service

provider.
P”F‘ter > Service operations should be performed only by qualified personnel who
Maintenance have been instructed in relevant safety precautions.

> Notify co-workers and those who have access to the J750 system before
beginning non-routine and hazardous work.

%{ Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

Model and Support materials are made of chemical substances. Although

g/llj)deéftnd precautions must be taken when handling these materials directly, all Model
M alggri als and Support materials used by the J750 system are handled in sealed

cartridges. Normally, operators of the printer should never be directly exposed
to hazardous materials. In the unlikely event of a leak or spill, follow the
instructions that are included with the printing-material cartridge used.

> Store Model and Support materials indoors, in a dry area with adequate
ventilation, between 15-25 degrees Celsius (59-77 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

> Keep Model and Support materials away from areas where food and drink
are stored, prepared and consumed.

> Uncured printing material is considered a hazardous substance, requiring
certain precautions when directly handling it. To prevent skin irritation,
wear neoprene or nitrile gloves. If there is any chance that Model and
Support materials might splash into the eyes, wear safety goggles.
Prolonged direct contact with printing materials can cause an allergic
reaction.

> When handling UV-cured models that may not be completely cured on the
surface, common latex gloves are adequate.

> To prevent respiratory irritation, ventilate areas where Model and Support
materials are used. If the printer is not equipped with an exhaust duct, the
room ventilation system should replace the air at least 20 times per hour.

> (Clean up Model-material and Support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl alcohol
(IPA), followed by soap and water. Dispose of the absorbent material in
accordance with local regulations.

> Do not wash contaminated clothing at home; clothing should be
professionally laundered.

> Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing material
may re-expose the user when these items are worn.
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UV Lamps

DOC-08040 Rev. A

UV lamps used by the printer to cure printing materials contain a small
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling
mercury vapor, and ventilate the room. If the lamp ruptures (breaks) during
operation, leave the room and ventilate it thoroughly for about 30 minutes.

Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that prevents
the generation of mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container. Dispose of the container in accordance with
applicable regulations.
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First Aid for Working with Printing Materials

Contact with
Skin

Contact with
Eyes

Ingestion

DOC-08040 Rev. A

In general, try to avoid direct contact with uncured printing material. If skin
or eyes come into contact with it, wash the area immediately and thoroughly
with water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing materials
contains important safety information. Keep this in an accessible place where
these materials are used and stored.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

> Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

> Do not use solvents to clean skin.

> If large areas of skin have been exposed, or if prolonged contact results in
blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

> Avoid the accidental transfer of printing material from the hands to other
areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet radiation.
Wearing contact lenses when handling liquid printing materials is not

recommended. If the liquid splashes into the eyes when contact lenses are
worn, immediately remove the lenses and flush the eyes with water.

> (lean and disinfect the contaminated lenses.

> Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.
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Inhalation

Vapors from printing materials can be irritating to the respiratory system. If
respiratory irritation occurs, expose the victim to fresh air immediately.

> If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

> Seek medical attention immediately.
> Keep the victim warm but not hot.
> Never feed anything to an unconscious person.

> Oxygen should be administered by authorized personnel only.

Waste Disposal

Printing
Materials

UV Lamps

DOC-08040 Rev. A

Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste (uncured
printing material).

> When removing the waste container from the J750 printer, wear
neoprene or nitrile gloves.

> To prevent liquid waste from splashing into the eyes, wear safety goggles.

> Liquid waste from the J750 printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and disposed
of in a manner that prevents human contact with it and contamination of
water sources.

> Empty Model-material and Support-material cartridges contain residue of
their contents. Some leakage of this residue may occur through the broken
cartridge seal. Therefore, handle and store empty cartridges with care.

> Do not attempt to reuse empty cartridges, and do not puncture them.

> Dispose of used cartridges and waste containers in accordance with local
regulations.

> Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

UV lamps used by the printer to cure printing materials contain a small
amount of mercury, and are considered “Universal Waste.” Recycle or discard
used lamps in accordance with applicable regulations.

Broken lamps:

After ventilating the area, use protective gloves and carefully remove spilled
mercury with a method that prevents the generation of mercury vapor, such
as a syringe, packing tape or paper. Place the broken lamp, mercury and
contaminated materials in an air-tight, non-metallic container. Dispose of the
container in accordance with applicable regulations.
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The advanced capabilities of J750 3D printing systems are made possible by
technology specially developed by Stratasys for printing models
simultaneously with up to six different Model materials. Print jobs can be set
up and sent to the J750 printer with either of these applications:

« PolyJet Studio
» GrabCAD Print

These applications are described in the following chapters. With both of
them, you can achieve the following results when printing 3D models on the
J750 printer:

« You can streamline and economize the process of producing models.

O Printing models made from different materials on the same build tray
(“mixed tray”), in the same print job, eliminates the time-consuming
need and expense of loading another material, flushing the system, and
sending a separate job to be printed.

O Alternating print jobs that use any of the Model materials (or material
combinations) loaded similarly does not require material
replacement—again, saving time and expense.

« You can print objects with combinations of basic materials (digital
materials), enabling you to choose from a wide range of possible
mechanical properties—from flexible to rigid.

* You can print parts (shells) of the same model—simultaneously—with
different materials (or material combinations)

« You can print objects that have a “coating” made from a different material
than the main part of the object.

« You can mix any combination of base materials, resulting in an extremely
wide range of available colors.

« If you designate colors for parts of a model at the design stage (with CAD
software) and save the model as a VRML file, the parts are automatically
assigned appropriate material combinations in PolyJet Studio for printing
the model with the desired colors.

Both PolyJet Studio and GrabCAD Print enable you to split models into
component parts (“shells”) so you can isolate, manipulate and print parts of a
model. Then, you can assign model materials and other characteristics to the
shells. However, you have ultimate control when separating models into
shells by preparing stl files with your CAD software.

GrabCAD Print supports many 3D CAD file formats, eliminating the need to
convert them to STL files. GrabCAD Print also automatically repairs damaged
files before sending them to the printer.
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Work Configurations

The Stratasys J750 3D printing system can be set up as a single-station system
or as a multi-station system. When connected to a local computer network,
the system can serve multiple users. In such configurations, each user (client)
prepares files for production. A software service, installed on the printer
computer, controls the printing.

Figure 3-1 shows the printer set up in a multi-client configuration.

Client

a workshions

printer

Figure 3-1 Multi-client network configuration
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Source Files

STL Files

VRML Files

DOC-08040 Rev. A

J750 printing systems produce three-dimensional models designed with most
CAD tools and some other 3D applications.
PolyJet Studio supports these file formats:

. STL

« VRML

GrabCAD Print supports STL and, VRML files, and, in addition, native CAD
formats from these programs: Creo, SOLIDWORKS, NX, CATIA and
Inventor. To see the complete list of file formats supported by GrabCAD
Print, go to: help.grabcad.com/print/file-formats.

J750 systems feature the capability of producing different types of model files
simultaneously.

STL is short for STereoLithography or Standard Triangulation Language.
This language views any object as a collection of surfaces, and describes each
surface of the object as a collection of triangles.

For example, a square can be described as two triangles; a cube (six squares)
as 12 triangles. Curved surfaces need more triangles to describe them. The
higher the tolerance (for smooth surfaces), the more triangles are needed.
The result is that high-quality object descriptions mean very heavy files.

Most CAD software can export STL files. PolyJet Studio opens these files for
printing models on the J750 printer.

VRML is a 3D file format which includes color and texture information.
VRML provides the ability to apply different colors and textures to a model
while designing models in a CAD program. No further color assignment is
needed in PolyJet Studio or in GrabCAD Print. (PolyJet Studio supports the
VRML 2.0 format, also known as VRML 97).

When you create a VRML file in CAD software, two files are created: a wrl
file, containing the model's geometric information of the model, including
texture, and a picture file (bmp, png, jpg, or tiff), containing the model's color
information. Before inserting a VRML file onto the build tray, save the VRML
file and its corresponding picture file in the same directory.
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Printing Materials

J750 printers produce models by jetting thin layers of printing materials on
the build tray, until the complete model is formed. Two types of material are
used in this process:

« Model material—which makes up the finished model

« Support material—which fills gaps and spaces in the model during
printing, and is removed after printing

% For up-to-date information about PolyJet printing materials and their
properties, go to www.stratasys.com/materials/polyjet.

Materials used for printing models with J750 printers are made of resins,
which are composed of reactive monomers and oligomers. Although printing
materials are supplied in sealed, UV-proof cartridges, care must be taken
when storing and handling them. Follow these guidelines to protect operators
and the environment, and to ensure optimum results.

Storage

« To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances (such
as polystyrene or polyvinyl chloride) are not suitable for storing PolyJet
printing materials.

« When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

« Store material cartridges indoors, in a dry area with adequate ventilation,
between 15—25 degrees Celsius (59-77 degrees Fahrenheit). If exposed to
heat or flames, cartridges might burst or ignite.

« Signs of premature polymerization in material cartridges include bulging,
leaking, the emission of heat, and unusual odor. Exposure to heat can
cause resin to gel in the cartridges.

« Make sure that material cartridges are stored in accordance with all local
regulations and other applicable requirements.

Shelf Life Materials used for producing models have a limited shelf life. The expiry date
on the label is valid when properly stored in an undamaged, unopened
cartridge. Always rotate your stock, so that the cartridge with the earliest date
is used first.

Exposure to If printing materials are not in their sealed cartridges, make sure to shield

Light them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.
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Safet_y ] Before being cured, resins are hazardous materials. To prevent possible health
Considerations hazards, follow these precautions regarding printing materials:

+ Do not expose to flames, heat or sparks.

« Prevent contact with skin and eyes.

« Ventilate areas where they are handled.

« Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

% You can find more safety information about resins in:

« "Safety Guidelines" on page 2-4
« "First Aid for Working with Printing Materials" on page 2-7

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.

Disposal

Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
the J750 3D printer. Use ventilation or air-conditioning systems, if necessary,
to keep the work area within the following ranges:

+ 18°-25°C (64°—77°F)
* 30%—70% relative humidity

Workstation Requirements
The requirements for client computers running PolyJet Studio are listed in
the J750 Site Preparation Guide. To download this document, click here.

To see the requirements for client computers running GrabCAD Print, go to:
help.grabcad.com/print/system-requirements.
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Preparing Files for Use with PolyJlet 3D Printing Systems

Converting
CAD Files to
STL Format

=

Converting
CAD Files to
WRL Format
(VRML)
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Before using design files with Stratasys 3D printing systems, make sure that
they are in a file format supported by the applications you are using to send
print jobs to the printer—PolyJet Studio or GrabCAD Print. (See "Source
Files" on page 3-4.)

This procedure may vary slightly, depending on the CAD software used, but
the following instructions generally apply.

To convert a file to STL format (ina CAD program):
1. From the File menu, select Save As.

2. In the Save As dialog box, open the Save As Type drop-down list and
select *.STL.

Some CAD tools provide the option to combine all assembly shells into a
single STL or to create a separate STL for every shell. The first option does
not enable you to assign materials or colors to individual shells. The second
option is preferred because it provides more flexibility when assigning
materials or properties to individual shells.

3. Click Options and set the following parameters:

O Total Quality—approximately 0.01 mm (deviation tolerance / linear-
dimension tolerance)

O Detail Quality—approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate models, but results in
larger files and longer loading and processing times. For this reason, it is
generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and ASCII
formats can be used in PolyJet Studio. However, binary files are smaller,
so this option is recommended.)

5. Click OK or Save.

After converting the model files, it is recommended that you check them for
defects before opening them in PolyJet Studio and producing the model. You
can do this in GrabCAD Print or in a third-party STL-repair application (such
as Magics™, by Materialise®).

For more information, download From CAD to Objet Studio Workflow for
Connex Technology.

You can save CAD designs as VRML files (WRL format) for printing. If you
assign RGB values or textures in the CAD design and then import the VRML
file in PolyJet Studio, Digital Materials that provide the best color match are
automatically assigned to the shells. The printer fabricates these Digital
Materials from the base materials loaded in the printer.

PolyJet Studio supports VRML 2 files (also known as VRML97 files).

3-7


https://stratasys.box.com/shared/static/g394ckb3l9z8o20rbe8ovd7nfgbz8dwi.pdf
https://stratasys.box.com/shared/static/g394ckb3l9z8o20rbe8ovd7nfgbz8dwi.pdf

Stratasys J750 User Guide 3 Introducing the Stratasys J750 3D Printing System

Applications for Preparing Print Jobs

PolyJet Studio

GrabCAD Print

DOC-08040 Rev. A

Both PolyJet Studio and GrabCAD Print offer you a wide variety of file-
preparation options that follow this basic procedure:

Defining the materials you want to use on the build tray
Inserting one or more objects on the build tray
Positioning the object(s) on the build tray

Configuring object and tray parameters

ok W por

Sending the file to a 3D printer for production

PolyJet Studio is an application for preparing print jobs on Stratasys 3D
printing systems. It consists of two main screens:

« Studio

e Manager

In the Studio screen, you prepare source files for production in the printer.
Using PolyJet Studio to perform these tasks is described in detail in Chapter
5, "Using PolyJet Studio".

The Manager screen displays the queue and status for all jobs sent to the 3D
printer.

GrabCAD Print is an application for preparing print jobs on a variety of 3D
printers, including the Stratasys J750. These are the main features of
GrabCAD Print:

» The same application prepares jobs for printing on multiple platforms,
including Stratatsys PolyJet and FDM printers (for supported printers, go
to: help.grabcad.com/print/printers).

« Support for many CAD file formats (see supported formats at
help.grabcad.com/print/file-formats).

 Automatic repair of 3D files.

« Scheduling and monitoring of multiple printers and print jobs, from local
and remote computers and from mobile devices.

« Intuitive design and ease of use.
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Workflows
With J750 printing systems, you have great flexibility in preparing model files
and printing them. Below are the major workflows available.
Stage Workflow A Workflow B Workflow C
CAD program* » Design a 3D object.  Design a 3D object. + Design a 3D object.
e + Saveitasasinglest/ + Saveitasan * Apply colors to parts.
o ] file. assembly of st/files. .« Save the object as a
F mh = VRML/wrl file.
PolyJet Studio / + Open (Insert) the st/ + Open (Insert) the st/ + Open (Insert)a
GrabCAD Print* file. files as an assembly. VRML/wri file.
————— + Separate the object + Assign materials to (wrl files confcain
— into its components the assembly’s model-material and
=S (“shells”). components. color information. )
* Assign materials to
the components.

«Save the build tray. / Send the build to the printer.

J750 Printer

e

Models are produced in the printer.

«Remove the Support material from the models

Finished model

Finished model.

3D printing workflows, from design to finished models

* In addition to the options shown, GrabCAD Print supports most native CAD file formats.
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PolyJet Studio

During printer installation, PolyJet Studio software is installed as a printer
server on the built-in printer computer. It is also installed on remote client
computers, to prepare models for printing or for training and demonstration
purposes.

This section is provided in case you need to reinstall or update PolyJet Studio
on the printer server, or to install it on a client computer. The PolyJet Studio
setup wizard guides you when installing this software. During installation, you
choose to install either the printer-server application or the client application.

To install PolyJet Studio software:
1. Connect the USB flash drive (supplied with the printer) to a USB port.

2. On the USB flash drive, navigate to the PolyJet Studio installation file, and
run it.

The following screen appears.

stratasys
PolyJet Studio Setup

Setup will install Polylet Studio on your computer.

Select which product to install and click one of the following
- 'Next' to continue.

- Close’ to exit Setup.

w, ,

M Install Polylet Studio Client

. Install Polylet Studio Server

- C |°se

Figure 4-1 Installation selection screen

3. Select the type of installation required—client or server (printer
computer)—and click Next.

When installation is complete, the following screen appears.
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stratasys
Installed PolyJet Studio

Setup has finished.
Would you like to restart the computer now or later?

-«

Restart Mow Restart Later

Figure 4-2 Final installation screen
4. Restart the computer to complete the software installation.

The installation process ends when the PolyJet Studio icon appears on the
computer desktop.

% If there is ever a need to uninstall the PolyJet Studio software, do not attempt
to do so from the Windows Control Panel. (This does not completely remove
all software components.) Instead—

From the Start menu, select All Programs > Stratasys > Uninstall PolyJet
Studio.
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GrabCAD Print

GrabCAD Print is an application for preparing and and managing print jobs
on the Stratasys J750 printer (and on other supported 3D printers). It is used
instead of the PolyJet Studio application installed on the printer computer,
and on remote client computers. To download GrabCAD Print, go to:
help.grabcad.com/print/sign-up.

To use GrabCAD Print for the J750 printer, GrabCAD PolylJet Server is
required on the printer server computer. This is the program that controls the
actual printing, and is used instead of PolyJet Studio Server. To download
GrabCAD PolyJet Server, go to: help.grabcad.com/print/j750.
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Launching PolyJet Studio

After you install PolyJet Studio, a launch icon @ appears on the Windows
desktop. Open the application by double-clicking this icon, or by selecting
PolyJet Studio from the Start menu.

Windows® 7 Depending on the User Account Control settings in Windows® 7, you might
Security see the following warning when opening PolyJet Studio.
Warning

-

¥yl User Account Control [&J

k@ Do you want to allow the following program from an
=/ unknown publisher to make changes to this computer?

Program name:  ObStudio.exe
Publisher: Unknown
File crigin: Hard drive on this computer

Change when these notifications appear

%

Figure 5-1 Security Warning

If you click Yes, PolyJet Studio opens. However, this warning message will
appear each time you open the application, unless you change the User
Account Control settings.

To prevent the warning message from appearing again:

1. Click the link at the bottom of the security warning dialog box (Change
when these notifications appear).

2. In the User Account Control Settings screen, move the slider to Never
notify.

"‘:,_-' User Account Control Settings El =

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer,

Tell me more about User Account Control settings
Always notify
- - Notify me only when programs try to make changes to
my computer (do not dim my desktop)
®  Don't notify me when I make changes to Windows
- - settings
S
i ﬁ' Mot recommended. Choose this only if it takes a long
- - time to dirn the desktop on your computer,
Mever notify

Fy OK ‘ | Cancel

Figure 5-2 Changing the User Account Control settings
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3. Click OK.
4. In the following dialog box, click Yes.

5 Using PolyJet Studio

@ |
?g' User Account Control ﬁ

Do you want to allow the following program to make

" changes to this computer?

= ] Program name:  UserAccountControlSettings
?-" Verified publisher: Microsoft Windows

() Show details [ ¥es |[ o

Change when these notifications appear

Figure 5-3 Confirming the change in the User Account Control settings

PolyJet Studio  The PolyJet Studio interface consists of two main screens:
Interface

» Studio—for arranging models and preparing them for printing.

« Manager—for monitoring and managing print jobs.
This screen is described in "Monitoring and Managing Print Jobs" on

page 5-43.
Studioand
Managertabs i ) Ribbon
Tray Explorer
panel .
Build
Tray
Maodel
Properties
panel
Status
—Bar

Figure 5-4 PolyJet Studio opening screen

Studio Screen

The Studio screen is controlled by ribbon icons and options in the Tray
Explorer panel.

PolyJet Studio displays and enables options relevant to your current task. For

example, certain icons on the ribbon are disabled until you place a model on
the tray.
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Tray Explorer
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The Tray Explorer panel lists the objects placed on the build tray in a parent-
child hierarchy. You can hide the Tray Explorer panel by clicking Ba.

Tray Explorer

- Trayl

-+ B [@ Assembly
= [™ wrench Key Shelll
B wrench Key Shell2
== M| Wrench Key Shell3

Figure 5-5 Tray Explorer (sample)

The Tray Explorer panel provides information about the models on the tray,
based on the properties selected in the Model Properties panel.

Assembly

Part with a glossy finish

Part with a matte finish

m Part with a coating applied

VRML part

H Part that is visible on the build tray (see "Assigning Properties to Hidden
Objects" on page 5-21)

. Part that is hidden from view on the build tray (see "Assigning Properties to

Hidden Objects" on page 5-21)

For example, the Tray Explorer panel shown above shows that the build tray
contains an assembly of parts:
« Shell 1 has a pink color with a glossy finish applied to it.

« Shell 2 has a yellow color with a matte finish applied to it. This part is also
hidden from view.

« Shell 3 has a light blue color with a black coating applied to it.

The Tray Explorer can contain multiple trays, but only the last tray added
can be edited. Close the last tray listed in the Tray Explorer to edit the
previous tray in the list.
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Status Bar
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The status bar in the bottom-right corner of the screen displays PolyJet
Studio's connection status and the type of printer it is connected to.

™ Connected Printer; Stratasys 1750, ID;

Figure 5-6 PolyJet Studio status bar
Status Bar indicators:
v/ PolyJet Studio is in offline mode (not connected to a printer).

& PolyJet Studio is connected to a printer.

@ PolyJet Studio attempted to connect to a printer, but the printer is off or
the server is not connected to a printer.
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Preparing Models for Production

Placing Objects
on the Build
Tray
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Model preparation involves the following basic steps:

1. Place objects or assemblies on the build tray.

2. If necessary, manipulate the object’s size, orientation and position.

3. Select the materials and model finish.

Just as J750 printers can produce different models on the build tray using

different materials, you can produce components of a model with different
materials. To do this, each part of the model must be a separate st file.

To print models, you open one or more files in PolyJet Studio and position
objects on the tray.

To place an object on the build tray:
1. Select the Home tab.
2. Click Insert and select Insert Model, Insert Assembly or Insert VRML.

File Home

Insert Model

Insert Assemblby

Figure 5-7 Insert menu
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The Open dialog box appears.

Open ]
@uv| » STL Files - | 43 | | Searnch STL Files o
Organize = Mew folder =~ 0 @

A Favorg— Mame Date modified Type
= DESEE Q batman.stl 29-Dec-14 5:05 PM Certificate Trust List
Tec; @ carstl 29-Dec-14 5:05 PM  Certificate Trust List
&l Rec G computer-rnouse.stl 20-Dec-14 5:05 PM  Certificate Trust List
App (9 door-stopper.stl 29-Dec-14 5:05 PM  Certificate Trust List
Cla (9 model-house.stl 29-Dec-14 5:05 PM  Certificate Trust List
Ohj (I robot.stl 28-Dec-14 5:05 PM  Certificate Trust List
Obj
y Yoz
£ Dro
l= Box
P ™ [Tl " b
File name: > [stlFiles (sth) (st -
| Open iv] | Cancel |

Figure 5-8 Open dialog box
3. Select a file and click Open.

You can open several files to place several models on the build tray by holding
down the Ctrl or shift keys and clicking on the required files.

QE{ You cannot place two different models with the same name on one build tray.

« If you clicked Insert Model and then selected multiple stl files, the stl files
are placed on the build tray as separate, individual models.

Figure 5-9 stlfiles placed as parts
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« If you clicked Insert Assembly and then selected multiple st! files, the stl
files are placed on the build tray as a single, integrated model. You can still
apply different properties to the individual parts of the integrated model.

Figure 5-10 st/files placed as an assembly

Duplicating If you need to duplicate objects on the build tray, you can place the same
Objects object from its file more than once. However, that method is not effective if
you want to duplicate an object that you have already modified in PolyJet
Studio. Instead, use the duplicate function.
To duplicate a model or an assembly:
1. Select the model or assembly on the build tray or in the Tray Explorer.

2. In the Edit group on the Home tab, select the number of copies to add on

- ~
the build tray = b
3. Click .
Copying You can copy the properties assigned to one object and apply them to other
Object objects on the build tray. The properties you can copy are:

Properties « surface finish (matte or glossy)

» model material and/or color
« coating thickness, model material and/or color
« hollow settings

% Dimension settings cannot be copied.

To copy object properties and apply them to other objects:

1. Select the object on the build tray or in the Tray Explorer with the
settings that you want to copy (source).

2. In the Edit group on the Home tab, click the Copy Settings icon .

3. Select the object on the build tray or in the Tray Explorer that you want
to apply the settings to (target).

% « You can only apply settings to one object at a time.
« Atleast two objects must be on the tray to use this feature.
« This feature is not available for VRML files.
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Selecting
Objects
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To manipulate an object on the build tray, or to assign properties to it (model
material, building style, etc.), you must first select the object. You select an
object by clicking it, either in the build tray or in the Tray Explorer. A yellow
frame appears around the selected object and its name is highlighted in the
Tray Explorer.

You can select multiple objects to assign properties to all of them.
To select multiple objects in the Tray Explorer:

> Press and hold the shift key or Ctr1 key while clicking additional
objects in the list.

> To select an entire assembly, click an Assembly entry in the Tray
Explorer.

[ Tray Explorer

=
2
&
%
z
g
5
B
=
A
o
E
g
E

Figure 5-11 Assembly selected (yellow outline)
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[ Tray Explorer

o) i—| Tray1l

=
2
&
%
5
g
5
B
=
&
&
o
E
g
E

Figure 5-12 Individual part selected (yellow outline)
To select multiple objects on the build tray:
> Press and hold the ctr1 key while clicking additional objects.

> Draw a box around the objects with the mouse cursor (only objects that
are fully surrounded by the selection box are included in the selection).

Figure 5-13 Selecting multiple objects

There is no limitation on the number or type of parts that can be selected. Any
collection of selected objects is valid.
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To select all objects on the build tray:

> In the Selection group on the Home tab, click the Select All icon E

To invert the selection of objects currently selected on the build tray:

_____

Assglgll’ling a | To assign a model material to objects:
Model Materia . .
to Objects 1. Select an object on the build tray.

When an object is selected, its properties are displayed in the Model
Properties panel. The model material color is also displayed in the Tray
Explorer.

2. Select the desired material (see "Changing the Model Material" below).

Changing the  1f polyJet Studio is connected to a printer, the Model and Support materials

Model Material  currently loaded in the printer are automatically selected. If PolyJet Studio is
being used off-line, default materials are loaded. The default materials cannot
be customized.

When designing a tray, you can use Model and Support materials that are not
currently loaded in the printer. To do so, you need to change (or add to) the
material selection in PolyJet Studio.

To view and change the material selection:

1. On the Home tab, click ueliESEd.

2. Make sure that the required Support material is selected from the
drop-down list.

3. In the Tray Materials selection window, select up to six (6) base materials
in the Material selection pane.

%{ « Remove some or all materials to make room for others.
e« Pressandhold shift orctrl toselect multiple materials.
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4. Click Add selected to move the selected materials to the Selected materials
section.

Tray materials

Selected materials:

FullCure705

1: RGD450

6: VeroCyan

Figure 5-14 Tray Materials selection window

5. Click OK.
The selected materials appear in the Base Materials section of the Model
Properties panel when a model is selected.

Maodel Properties
Finish | @ Matte N GloSSY

Coated model

Figure 5-15 Base materials available

Digita_l You can produce models from a combination of materials to attain different
Materials shades of color and mechanical properties.
There are two ways to apply material combinations to models:

« by selecting from a list of pre-set digital materials
« by applying a custom color (created dynamically from the base materials
available)

To select a pre-set digital material:
1. Select a model on the build tray or in the Tray Explorer.
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2. In the Model Properties panel, select a digital material group from the

Filter by drop-down list.

Model Properties

Finish | @ mMatte [N GlasSy

Coated mod

Base Materials: [ ] [ N |
Filter By
DM _VeroBlack VeroCyan
DM _VeroBlack VeroCyan
DM_VeroBlack_VeroWhite
DM _VeroCyan_VeroWhite
DM_VeroBlack_VeroYellow
DM_VeroCyan_VeroYellow
DM_VeroWhite VeroYellow

M VernRlack Vernhaont

Actual

Figure 5-16 Selecting a pre-set digital material
The Digital Material palette appears.

Filter By

DM _VeroBlack VeroCyan
O

Digital Material
palette

Figure 5-17 Digital Material palette
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3. Select a digital material from the palette.
The Selected and Actual color swatches change to the color you selected.

When selecting a pre-set digital material, the "Actual” color is identical to the
"Selected" color.

To apply a custom color (from the base materials available):
1. Select an object on the build tray or in the Tray Explorer.

2. Make sure that the materials selected in the Tray Materials screen include
at least all of the following materials:

O VeroBlack

O VeroCyan

O VeroMgnt

O VeroPureWht
O VeroYellow

The Color Picker is not available unless all of these base materials are
selected.

Tray Materials

Support:

FullCure705

) ) Selected materials:
Material selection:

Base Materials FullCure705

RGD535 : VeroBlack

. Tango+
TangoBlack+

: VeroCyan
: VeroMgnt

VeroBlack : VeroPureWht

: VeroYellow
® veroBlue

6: VeroClear

I ® veroClear |

VeroCyan
® veroGrey

VeroMgnt
@ VveroPurewht
® veroYellow

Color profile for color picker | Stratasys Colorimetric ¥

Color profile for texture Stratasys Colorimetric ¥

Figure 5-18 Tray Materials selection window

In addition to these materials, adding VeroClear enables you to adjust the
opacity (translucence) of the color in the printed model (see below).
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3. In the Model Properties panel, select Color Picker from the Filter by drop-
down list.

Filter by

Color Picker

Color Picker

DM _VeroBlack VeroClear
DM_VeroBlack_VeroCyan
DM_VeroClear_VeroCyan
DM_VeroBlack_VerohMgnt

DM_VeroClear_VeroMgnt

Figure 5-19 Filter By dropdown list
The Color Picker appears.

Filter by

Color Picker

Oipacity (%)

Selected
Add to palette =

Actual

Figure 5-20 Color Picker
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4. Click in the Color Picker and use the mouse to select a color.

O The selected object on the build tray changes color.

O The Red, Green, and Blue fields update to show the new RGB values.
O You can enter exact RGB values, if required.
m

If VeroClear material is available, you can adjust the opacity
(translucence) of the color applied to the model.

O The Selected and Actual color swatches change to show the selected
color and the result in the printed model.

%{ The "actual color" is the closest color to the selected color that can be printed.

Model Properties: Chinese Box_New

Finish | @ Matte |8 Glossy

Coated model

Assigned: 162,15, 163

Base Materials: [ |
Objectdisplayed in
Filter by the selected color

Color Picker

Red: RGB
Color y T values
picker—=—— " i(E] e
Green:
15: [
~
Opacity
EERL B Opacity (%):
Selected
¥ =2 Selected /
Add to palette Actual colors

Actual

Figure 5-21  Color picker result

You can save the new custom color (material combination) and often-used
base materials and digital materials in custom palettes (see below).

You can keep a collection of often-used base materials, digital materials and

E’ll;iéclfgl custom colors (material combinations) in custom palettes. This allows you to
Palettes easily apply them when preparing models for printing.

To create or edit a custom material palette:
1. Select an object on the build tray.

2. In the Model Properties panel, select a material—a base material or a
digital material—or set a custom color.

You can set a custom color with the Color Picker or with the
Red/Green/Blue controls.
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Model Properties:

Finish | @ Matte |88 Glossy

Coated model

B RGD-CMW-011-DM
mn

Assigned:
Base Materials: )]

Filter by
DM _VeroCyan VeroMgnt VeroPureWht
Red:
a

* Green:

Selected
Add to palette =
Actual

Figure 5-22 Selecting a material or color

3. Click Add to palette.
The Custom Palette dialog box opens.

Custom Palette

Enter new palette

Figure 5-23 Custom Palette dialog box

Model Properties: robot

Finish @ Matte | ® Glossy

Coated model

B 113 220 218
|

Assigned:
Base Materials: [}

Filter by

Color Picker

Opacity (%6):

Selected
Add to palette ~
Actual

4. When creating a palette, click Enter new palette, type a name and click

OK.

The dialog box closes, and the new palette, with the selected
material/color, is added to the Filter by list.

5. When adding the selected material to an existing palette, click the palette

name and click OK.

The dialog box closes, and the selected material is added to the palette.
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Surface Finish  Models can be printed with a matte or glossy surface finish. To create a matte
finish, the printer surrounds models with a thin layer of support material.

To set the model finish:
1. Select the model.
2. In the Model Properties panel, click Matte or Glossy.

Finish ® Matte [ Glassy

Figure 5-24 Matte and Glossy model finish selection

When you select Glossy, an icon with a "glossy" symbol appears next to the
object in the Tray Explorer in the assigned color 58,

When you select Matte, a matte icon (no glossy symbol) appears next to the
object in the Tray Explorer in the assigned color ]

Coating You can print composite models where the surface layer is a different material
Objects than the inside. This can be useful to achieve unique mechanical and textural
characteristics. This technique is called “coating.”

%{ Digital ABS material cannot be applied as a coating.
Coating cannot be applied to—

« VRML files
« hollow models
« objects when Digital ABS material is selected

To coat an object with a Model material:
1. Select the object on the build tray.
2. In the Model Properties panel, select the Coated model check box.

v Coated model

Thickness (mm) 0.1

Figure 5-25 Coated model check box

3. In the Thickness field, enter a coating thickness between 0.1 and 1
millimeter.

Note: The coating thickness does not affect the external dimensions of the
object, which remain unchanged. The coating layer replaces part of the main
model material.

4. Click Coating.

Model Coating

Figure 5-26 Material selection for Coating
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5. Select a coating material.

Important:
« If there are two shells of a model that are coated, the same material must
be used.

» When Coating is selected, the material selected in the Model Properties
pane applies to the coating, not to the model. To set the model material
and colors, click Model.

» You cannot use the color picker or set RGB values for the coating material.

When a coating material is applied to an object on the build tray, the icon in
the Tray Explorer shows the coating color B

“|_'|C_’”0W"_ Many objects placed on the build tray are “solid.” This means that, when

FI!IIng Models  printed, the model will be completely filled with Model material. Often,

with S_U pport  especially with large objects, this is unnecessary. Instead, the model can be

Material filled with Support material, which is less costly. It is also advisable to fill
models with Support material when preparing them for investment casting,
since this material burns off more quickly during the process of making the
cast.

PolyJet Studio enables you to print objects on the build tray with an outer
shell of model material and a center filled with Support material.

Important: When using this feature, called “Hollow,” the thickness of the
shell should be no less than 0.28 millimeters.

To use the Hollow feature:
1. Select a model on the build tray.

2. In the Advanced Properties section of the Model Properties panel, select
Hollow.

* Advanced Properties

V¥ Hollow

Shell Thickness (mm) 0.25

Figure 5-27 Hollow selection
3. Set the shell thickness (in millimeters).

Note: Thereis no change in the display of objects in PolyJet Studio when
Hollow is selected.

% A model cannot be both hollow and coated (see "Coating Objects" on the
previous page).
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Assigning To enable you to assign materials and other properties to parts of objects that
Propertiesto  are hidden from view on the build tray, you can temporarily turn off the
Hidden Objects display of some objects.

» When an object is displayed, & appears next to its name in the

Tray Explorer.
« When an object is hidden, [~ appears next to its name in the

Tray Explorer.
To display or hide an object on the build tray:

> In the Tray Explorer, click B or [=] to display or hide the object on the
build tray.

Tray Explorer

©® [F Tray1

— B [Tl Assembly

saipadoid jBpo ¥

Wrench K

3 2] Assembly
Wrench Key_Shelll
B wrench Key_Shell2
2 [ wrench Key_Shell3

Figure 5-28 Hidden object on the build tray
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Preparing
VRML files for
Printing

DOC-08040 Rev. A

VRML files contain color information. After placing a VRML file on the build
tray, PolyJet Studio assigns each shell a digital material that provides the best
color match. Therefore, the color selection options in the Model Properties
pane are disabled.

You can apply a matte or glossy finish to VRML models, and you can resize
them.

1.

Make sure that all of the following materials are selected:
3 VeroCyan

O VeroMagenta

O VeroYellow

O VeroBlack

O VeroPureWhite

You can select up to six materials, but when printing VRML files, only the
materials mentioned above will be used.

To optimize placement of the model(s) on the tray, click Placement (see
"Automatic Positioning" on page 5-26).

To ensure that the tray meets all requirements, click Validate (see "Tray
Validation" on page 5-35).

To estimate the printing time and amount of material for this print job,
click Estimate (see "Production Estimates" on page 5-36).
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Opening Tray  You can open trays that were saved as objtf files (see "Saving Trays " on
Files page 5-39).

%{ The objtffile contains instructions for printing—which files to print and their
position on the build tray. Because the objtffile references the st/ and vrmlfiles
used, they must remain in the same file location as when the objtffile was
saved.

To place an object saved as a tray file (objtf) on the build tray:

1. From the File tab, click Open and select Open Tray.
The Open dialog box appears.

Open
@Uv| » Tray Files - | +y | | Search Tray Files o
Organize = MNew folder gz = [ -ZQI

Name Date modified Type Size
!:E | (9 Models for Demo.obijtf 15-Mar-1512:12A.., O
(9 Models for Marketing.objtf 15-Mar-1512:12 A... Obje
:ﬁ'
i - 4 I b
File name: ~ | objtf Files (.objtf) (".obith) -

| Open iv| | Cancel |

Figure 5-29 The Open dialog box
2. Select the desired file, and make sure that it appears in the File name field.

3. Click Open.
The Select Printer dialog box appears.
PolyJet Studio opens the tray file.
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Opening
Packed Tray
Files (objzf)

%

DOC-08040 Rev. A

All objzf files are compressed files containing the objtf tray file and the
referenced model files (see "Saving Trays " on page 5-39).

To use trays saved as objzf files, the file must first be unpacked in PolyJet
Studio and its component files saved.

Note: If you pack an objzffile containing an st/ file originally saved as read-only,
you cannot unpack this objzffile to the folder where the read-only st/file is saved.

Unpacking an objzf file creates a new build tray.

To unpack and open an objzffile:
1. On the File tab, click Open > Unpack Tray.

-

Open

-

F-_I OpenTray

@

Figure 5-30 Unpack Tray opens an objzf file
2. In the Open dialog box, display the appropriate folder and select the file.
3. Click OK.

4. In the Browse For Folder window, navigate to the location where you
want to extract the objzf file and click OK.

Browse For Folder @

Select folder to extract Objzf files

Bl Desktop -
4| o Libraries

4 3 Documents

m

1 My Documents
, Public Documents
> J’- Music
» || Pictures

Cuhararcinm

[ Make Mew Folder ] [ oK ] [ Cancel

Figure 5-31 Browse for Folder window
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5. In the Select Printer dialog box (see below) connect to a printer or select
Work Offline and click OK.

Select Printer

® Connect to Printer

Work Offline

157.0.0.1

Enter new printer name or IP address

Figure 5-32 Select Printer dialog box (sample)

« Connect to Printer
A printer can be listed by its name or by its computer's IP address. To add
a printer, click in the place indicated and enter its identifier.

« Work Offline

Select a printer type so you can prepare trays that are suitable for the
relevant tray size and printer features .

PolyJet Studio opens the file.

Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important to
carefully position objects on the tray. You should check to make sure that the
objects are orientated optimally for your needs, according to the
considerations explained in "Manual Positioning" on page 5-27.

Two things that affect the positioning of objects on the tray are orientation
and placement. You can let PolyJet Studio determine the optimum
orientation and position, or you can control them.
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Automatic After placing several objects on the build tray, you can let PolyJet Studio
Positioning arrange them before printing. This ensures that the objects are positioned
properly, and that they will be printed in the shortest time.

Automatic positioning will not work if the Rotate values are locked. See
"Setting Model Dimensions" on page 5-29.

To automatically arrange objects on the build tray:

Figure 5-33 Build tray before clicking Placement

Figure 5-34 Build tray after clicking Placement

« The physical characteristics of each type of Model material you use can
affect the positioning of objects on the build tray. Therefore, select materials
before clicking the Placement button.

« Thefirst priority used by automatic placement is printing quatlity. Therefore,
to optimize quality, some parts might be placed diagonally, which takes
much longer to print.
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Man_l«!a| _ You can change the position of objects on the build tray—even if they were
Positioning arranged with the Placement option.

The orientation of models on the build tray affects how quickly and efficiently
they will be produced by the printer, where and how much Support material
is used, and whether or not model parts will have a glossy finish. Therefore,
you should consider a variety of factors when deciding how to place models
on the build tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along the
Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

> Any surfaces that come into contact with Support materials become matte.

> Since models are built up, on the Z-axis, in 16- or 30-micron layers
(according to the printing mode), it is very time-consuming to print a tall
object. From this point of view, it is advisable to place the object's smallest
dimension along the Z-axis.

> Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in one
pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

> Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the build tray, the print heads only have to scan
the model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

The following rules are based on the fact that Support material is not required
on the top of the printed model.

Recess-Up Rule
This rule considers models containing surface recesses.

> Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.
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Fine-Surface Rule

This rule considers models that have one side on which there are fine details
(like the keypad side of a telephone).

> The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.

Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at least
one side (like a pipe or a container).

> It may be advantageous to print a model standing up, so Support material
does not fill the hollow, even though printing the model lying down would
be much faster.
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Manipulating Objects on the Tray

Setting Model
Dimensions

DOC-08040 Rev. A

The Dimensions section of the Model Properties panel enables you to make
fine adjustments to objects on the build tray along the X, Y, and Z axes. After
changing a value, click in another field in the Dimensions group to apply the
new setting,.

Rotate—You can rotate an object by entering the required values in the
Rotate fields. Click the lock button to lock the Rotate fields. This prevents
automatic placement from changing the rotation of the object on the build
tray.

The X, Y, and Z dimensions are retained from the original part design and are
not changed when you re-orient the model.

Move—You can move the object to a specific position on the build tray by
adjusting the values in the Move fields.

Resize—You can change an object’s dimensions by adjusting the values in
the Dimensions fields.

Scale—You can change the scale of an object by adjusting the values in the
Scale fields. If Uniform Scale is enabled, changing the object’s dimension on
one axis affects the other dimensions, proportionately.

* Dimensions
X

Rotate 180 C : Lock
button

Move 121027

100
1
¥ Uniform scale

Criginal Model Units:

MM bl

Figure 5-35 Dimensions section of the Model Properties panel
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Manually You can change the position of objects on the build tray. Considerations for

gg?oggtioning positioning objects are presented in "Manual Positioning" on page 5-27.
jects

To manually reposition an object:

1. Select an object by clicking it on the build tray, or selecting it in the Tray
Explorer.

A frame appears around the object.
2. Click and drag the object to move it on the build tray.

Figure 5-36 Moving an object on the build tray

Re-aligning
Objects To re-align an object:

1. Select an object on the build tray.

2. Display the Home ribbon and click Align to Plane i
3. Click on the plane of the object you wish to re-align.
The plane-alignment toolbar is displayed for the selected plane.
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Figure 5-37 Align to Plane
4. Select one of the icons to re-align that plane of the object.

Display Options
Viewing From the View tab, you can change the way objects are displayed. The default
Objects method for displaying models on the build tray is as solid objects.

Figure 5-38 Build tray and model displayed in Shaded view
The other display option is Wireframe.
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To display models on the build tray in Wireframe view:

> From the View tab, in the Model Display group, click Geometry and select
Wireframe.

Figure 5-39 Build tray and model displayed in WireFrame view

To revert to the solid view:

> From the View tab, in the Model Display group, click Geometry and select
Solid.

To display the maximum build height:
> From the View tab, in the Tray Display group, select Display 3D Box.

Figure 5-40 3D box view
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Tray The default perspective of the build tray is “Left Front.” You can change the
Perspective perspective of the active window with one of ten options.

To change the perspective of the build tray display:
1. On the Home tab, in the Tray View section, click Isometric.

Figure 5-41 [sometric menu
2. Click the option that represents the desired perspective.

Tray
Positioning To change the position of the build tray on the screen:

> Hold down the shift key and the left mouse button while moving the
mouse.

Figure 5-42 Build tray after moving it
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To manually rotate the build tray:

> Hold down the right mouse button while moving the mouse.

Figure 5-43 Build tray after rotating it

To reset the build tray position, select one of the options from the Isometric
menu.

Zooming While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

> Scroll the mouse wheel forward (to zoom in) or backward (to zoom out).
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Handling Trays

After preparing models on the build tray, you can do the following:
« Test that it can be printed ("validation").
« Calculate the time and material resources needed to print it.
« Send it to the printer for production.
« Save it for later completion or printing.
« Save it as a compressed file for convenient storage and transfer.

Tray Validation Before sending a job to the printer for production, you should check that the
tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of model material,
make sure that the correct material is selected before performing Tray Validation.

To validate that the tray can be printed:

> On the Home tab (in the Job group) click

If the tray is not valid for printing, an error message appears, and the
problematic model is surrounded by a red box.

Invalid model
placement

Figure 5-44 Invalid build tray

QE{ Even if more than one model is the cause of an invalid tray, only one model at
atime is surrounded by a red box. When you fix the placement of the model
indicated, validate the tray again to make sure that the tray is now suitable for
printing.
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Pro_d uction PolyJet Studio enables you to calculate the time and material resources

Estimates needed for producing trays before sending them to the printer. The time it
takes PolyJet Studio to perform this calculation depends on the number of
objects on the tray and their complexity. Calculating the production estimate
for a full tray could take up to 15 minutes, depending on your computer’s
specifications.

To calculate the time and materials needed for producing the current tray:

&fs

> On the Home tab, in the Job group, click E==8.

When PolyJet Studio finishes calculating the production resources, the results
are displayed in a dialog box.

Production Estimate

Print Modes Print Time FullCure?05  Materials Total Consumption (gr)

326

B High Mix 320 302

Figure 5-45 Production Estimate screen

Click [ and 3 to expand and collapse the Print Modes to reveal the estimated
consumption of every Model and Support material needed to print the tray.

The estimated material consumption is displayed in grams.
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Printing the

To print the tray:
Tray pri y

1. On the Home tab (in the Job group) click
The Build dialog box opens.

Build

Select Mode: (@) High Quality High Mix

Figure 5-46 Build dialog box
2. Select the printing mode and click Build.

%{ For an explanation of printing modes, see "Printing-Modes" on the next page.

The Save As dialog box opens.

) Save As
@I@vl b Trays - | 44 | Search Trays el
Organize = Mew folder TR .gj.
o Fa\‘| = MName ‘ Date modified Type Siz
. Dl ‘=| (9 Models for Trade Show.objtf 09-Jun-1510:44 PM  CbjetStudio.Sheli...
T (D Prototype.abjtf 09-lun-1510:44 PM  ObjetStudio.Shell..,
s T
= R
A
C
, C
C
i [ 1 . b
[ et el odels for Marketing obitf -
Save as type: | objtf Files (.objtf) (*.objtf) -

# Hide Folders [ Save ] I Cancel |

Figure 5-47 Save Asdialog box
3. In the Save As dialog box, save the tray.
The Manager screen opens and the model is placed in the job queue.

When a tray is ready to be printed, it is placed in the Printing Queue. When
the job reaches the head of the queue, PolyJet Studio pre-processes the tray
file to create slices, and feeds them to the printer.
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Printing-Modes When printing the tray file, the Build dialog box opens in which you need to

DOC-08040 Rev. A

select the appropriate printing mode. (See "Printing the Tray" on the previous
page.)
High-Speed Mode

Models are produced in 27-micron layers, using up to three Model
materials. This mode is suitable for producing larger models.

Much less time is required to print most trays, compared to the High Quality
setting.
High-Mix Mode

Models are printed in 27-micron layers, using up to six Model materials. This
mode is suitable for producing larger models.

Printing models in this mode is faster than in High Quality mode, but not as
fast as in High-Speed mode.
High-Quality Mode

Models are printed in 14-micron layers, using up to six Model materials. This
results in smooth surfaces, suitable for producing fine-detailed and delicate
items.

Almost twice as much time is required to print most trays, compared to the
High Speed setting.
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Saving Trays  After preparing a build tray in PolyJet Studio, you can save it as a tray file
(*.objtf). This file contains all of the information about the build tray—which
model files to print, their properties, and their position on the build tray.
Saving a tray file is useful for finishing or printing the tray at a later time.

Because the objtffile references the st/ and vrmlfiles used on the tray, do not
move them; they must remain in the file locations where they were when the
objtf file was saved.

You can also save a tray as a "packed" file (*.objzf), which contains the tray
file and all of the model files in one compressed file. This is convenient for
backing up, storing and transferring tray files.

To save a tray file (*.objtf):

> Display the File tab and click Save.

Figure 5-48 Save button

« If the tray was not saved previously, the Save As dialog box appears. Enter
a file name and click Save.

« If the tray was saved previously, the current tray overwrites the previous
one.
To save a saved tray with a different file name (*.obijtf):
1. Display the File tab and click the arrow under the Save icon.
2. In the drop-down menu, click Save Tray As.

e Pack Tray

Figure 5-49 Save menu
The Save As dialog box appears.

3. Enter a file name and click Save.

To save the tray and all associated files as a compressed file (*.objzf):
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1. Display the File tab and click the arrow under the Save button.
2. In the drop-down menu, click Pack Tray.

Figure 5-50 Compressing the contents of a tray file
The Save As dialog box appears.
3. Enter a file name and click Save.
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Opening a New you can open a new instance of the build tray without closing the build tray
Build Tray that is currently displayed. After doing so, however, you need to close it to
return to the previous build tray.

To display a new build tray:
1. From the File tab, click New.
The Select Printer dialog box opens.

2. Select a printer or select Work Offline and click OK.

Select Printer

® Connect to Printer

Work Offline

( printer IP)

Enter new printer name or IP address

Figure 5-51 Select Printer dialog box (sample)
» Connect to Printer

A printer can be listed by its name or by its computer's IP address. To add
a printer, click in the place indicated and enter its identifier.
» Work Offline

Select a printer type so you can prepare trays that are suitable for the
relevant tray size and printer features.
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An empty build tray appears.

Figure 5-52 New build tray

3. Place an object on the build tray (see "Placing Objects on the Build Tray"
on page 5-7).
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Monitoring and Managing Print Jobs

You manage print jobs sent to the printer in the Manager screen. Display this

screen b& clickinf the Manager tab at the top of the PolyJet Studio window

Manager Screen

Figure 5-53 Manager screen
The Manager screen includes the following sections for monitoring print
jobs:
« Printing Queue
« Print Progress
 Recent Jobs
» Materials

« Tray Preview
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Printing Queue

Printing
Progress
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The Printing Queue displays information for each of the queued jobs:

« Tray Name—the tray (objtf file) sent for printing

« Owner—the computer that sent the job
» Mode—the print mode used for the job
« Status—the status of the job (Ready, Completed...)

Printing Queue

Owner Mode

Tray Name

Training_bt_cs

Tray 1
ray (ILD3-TESTTRAIN}

High Mix

Figure 5-54 Job in Printing Queue

" o n

To see more job details, click the "+" expansion icon.

Printing Queue

Tray Name Owner Mode Status

Training_bt_cs

{ILO3-TESTTRAIM)
VeroBlack
32 gr

Tray 1 High Mix Ready
VeroPureWht
620 gr
Queue:
Ready:

VeroCyan
32 gr
1747 28-01
07:25 29-M1

VeroClear
32 gr

VeroYellow
144 gr

VeroMgnt
32 gr

Figure 5-55 Job Details in Printing Queue

The Print Progress section displays the following information:
« time remaining to finish printing
« estimated time when printing will end
« number of slices printed and the total number of slices
« progress bar
« job start time

Print Progress

Estimated end time:

31-03

Time Remaining:

0d 0:37:41

Slice Printed: 2428 of 2782

Printing 87%

Job Started: 11:14 31-03

Figure 5-56 Print Progress

Status

Ready

FullCure705

444 gr

5-44



Stratasys J750 User Guide

5 Using PolyJet Studio

Recent Jobs The Recent Jobs section displays information about previous jobs and their

final status.

Recent Jobs

Tray Name Owner

iray 1 (||_:)3—TE§.‘I'I:RAIN)

Training_bt_cs
(ILO3-TESTTRAIN)
Uri.Mann (ILOT-
CHTTBW1)

Tray 6

Liver_mm

Queue: 1547 12-01

Ready:  15:49 12-01

Print: 15:50 12-01

Finish:  23:07 12-01

Ur.Mann ({ILOT-
CHTTBW1)

Figure 5-57 Recent Jobs

Liver_mm

Mode
Hign Mix

High Mix

High Mix

High Mix

Status
Error

Error

Completed

To see more job details, click the "+" expansion icon.

Availaple The Materials section displays the amount of available printing materials
Materials remaining in the printer and the amount of waste in the waste container.

The Job Requirement values indicate the amount of printing materials

required for the current job.

Materials

FullCure705

Left(gr)

Job Requirement ( gr }

Figure 5-58 Materials panel in the Manager screen

Tray Preview The Tray Preview displays the tray view of the job selected in the Printing

Queue or the Recent Jobs section.

Figure 5-59 Tray preview

DOC-08040 Rev. A
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preview
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Setting the
Printer
Connection
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You may need to set (or reset) the connection between a client PC and the

PolyJet Studio server, or between the PolyJet Studio server and the printer-
control program.

To set the printer connection:

2. In the Select Printer dialog box, make sure that Connect to Printer is
selected.

3. Select a printer from the list and click OK.

Select Printer

® (Connect to Printer

Work Offline

( printer IP)

Enter new printer name or IP address

Figure 5-60 Select Printer dialog box (sample)
Note: A printer can be listed by its name or by its computer's IP address.

To add a printer:

> Click in the place indicated and enter its identifier.
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Job The following operations are available on the Manager screen:

Commands

Icon

Purpose

» Forajob selected in the Printing Queue—Prints it again (from the
beginning).

» Forajobinthe Recent Jobs list—a new job, identical to the selected
job, is created.

Stops ajob in progress.

Continues printing the current job. (You enter the slice from which to
resume printing.)

Delete job

Moves the selected job from the Printing Queue to the Recent Jobs list,
where its status is "Aborted."

Printing Jobs  If there is a job in the Printing Queue, it is sent automatically to the printer—
from the as long as it is turned on, there is a connection to it, and it is in "on line"

Printing Queue mode.

Chapter 6 describes starting and operating the printer.

Resuming Jobs If the printing process is stopped or interrupted, you may be able to continue
printing the job. You need to enter the slice from which to resume printing.

& Caution:

If you want to resume the job from slice 0, the printer raises the build tray. If
you have a partially printed model on the build tray this could cause damage to

the printer.

If you want to print from slice 0, do not resume the job, restart it, instead. See
"Restarting Jobs" on the next page.

To resume printing:
1. Select the job.

DOC-08040 Rev. A
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Jobs
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3. If the print job was stopped and then resumed, the next slice appears in
the Resume From Slice dialog box. Click OK.

4. If the print job is resumed after a failure, enter the slice from which to
resume printing and click OK.

Resume From Slice

Resume from

Figure 5-61 Resume From Slice dialog box

When you restart a print job, PolyJet Studio assumes that the printer tray is
clear. The printer raises the build tray to the start position and PolyJet Studio
sends data from slice 1.

You can restart jobs from the Recent Jobs list or from the Printing Queue.

Torestart ajob:
1. Select a job.
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Printer cover

Materials cabinet

Figure 6-1 The Stratasys J750 3D Printer

Starting the Printer

& Caution

Do not attempt to operate the printer before being trained by a Stratasys
Customer Support representative.

« Observe all safety warnings and follow the safety guidelines described in
Chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2 Main power switch and cable
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2. After the printer-control computer boots, log in to Windows and launch
the printer-control program:

%{ A HASP plug containing a valid product activation key is required on the
printer computer. This is installed at the factory or during printer upgrade. If
the application does not open and a HASP message appears, contact your

dealer or Stratasys Customer Support.

All monitoring and controlling of the printer is done from this interface.

3 . =

M3-L

Printer mode

7 4 | 400 gr
i i 'Vgl_'DC\fan

M2-L
Current activity —

| 400 gr. |
VeroClear

| Previous job last slice: 9 b

Support ——
materials

i | [ |

Display toggle — g —

button

Stop button

Cabinet A

=
M3-R

| 400 gr
VeroCyan

M2-R

| 400 gr |
VeroClear

MI-R

Figure 6-3 Stratasys J750 interface

DOC-08040 Rev. A

19 0ct2015  18:33
Cabinet B
FullCure705  FulliCure705 {

— Support materials

[

Maodel materials
Ve.roYeIk::lw Ve_.roYeIk::lw

M5-L M5-R

a00gr| [400gr)
VeroWhite  VeroWhite

M4-L M4-R |

400 gr |

Online/offline
button

Pause button
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Loading Model and Support Cartridges

J750 printers use up to 12 cartridges of Model material and up to four
cartridges of Support material, each weighing 3.6 kilograms when full. A
graphical representation of the cartridges loaded and their current weight
appears in the printer interface (see Figure 6-3 on the previous page).

% The material cabinet contains cartridges of printing material. For this purpose,

DOC-08040 Rev. A

an RFID module is built into the cabinet. Tampering with this module will
render the printer inoperable and may void Stratasys warranties and service
contracts.

Important: [f you need to replace the Model material currently installed with
another type, see "Changing the Printing Material" on page 6-14. Otherwise,
make sure to replace the Model cartridge with one containing the same type of
material.

To load Model and Support material:
Open the doors of the material cabinet.

2. Load Model and Support cartridges into their respective compartments.
You should feel some resistance, as a needle pierces the cartridge.

3. Check the printer interface to make sure that the new cartridge is detected
and that its weight is displayed (see Figure 6-3 on the previous page).

4. Close the material cabinet.

Tips about loading and replacing material cartridges:

« You can load partially used cartridges, provided that they contain more than
100 grams of material.

« You can replace material cartridges either before or during printing.

« If printing stops for an extended time before you replace a material cartridge,
the printer may go into Standby or /dle mode. If this happens, see "Resuming
Production After Printing has Stopped" on page 6-11.

« You can replace partially used cartridge to avoid the need for replacing them
during printing.

« The cartridge type is automatically detected by the printer. If you replace a
cartridge containing different Model material, a message appears
recommending that you run the Material Replacement wizard to flush out the
old material.
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Producing Models

Models can be printed after they are arranged on a virtual build tray in a 3D
printing application. Two such applications are available for preparing trays
for printing on the J750 printer:

« PolyJet Studio

» GrabCAD Print

For information about preparing model files for printing, see the relevant
documentation—

« "Using PolyJet Studio" in this user guide
¢ GrabCAD Print online documentation.

Preparing the
Printer

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
"Pattern Test" on page 6-32).

To prepare the printer for producing models:
1. Make sure that the build tray in the printer is empty and clean. If not,

remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

Caution

Use protective gloves when cleaning the build tray, and be careful of the
sharp edges of the scraper blade.

2. Make sure that there is sufficient Model and Support material loaded, as
indicated on the printer interface (see Figure 6-3 on page 6-4). You may
want to replace the cartridges of Model and Support material currently
loaded in the printer to avoid the need for replacing them during printing.

For installing material cartridges and replacing empty ones, see "Loading
Model and Support Cartridges" on the previous page.

For changing the type of Model material currently loaded, see "Changing the
Printing Material" on page 6-14.

3. On the printer interface, click the red button to switch the printer to
online mode.

The color of the button changes from red to green (see Figure 6-4 on
page 6-8). If there is a job in the printing queue, it is sent to the printer.
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When switching the printer to online mode, a message is displayed if a
maintenance activity is required to ensure optimum printing quality. (See
"Routine Maintenance Schedule" on page 6-29.) Maintenance natifications
can be disabled/enabled from the Options menu.

On the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

« The print block is heated.
« The UV lamps are powered and they warm up.

When printing begins, the print manager program sends seven slices to the
printer-control application. This is the standard buffer between the print
manager and the printer. As each slice is printed, another slice is sent to the
printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model and
Support material in the supply cartridges, printing proceeds automatically
until the job is finished.

The J750 printer uses up to six different Model-material cartridges to produce
models. In addition, two Support-material cartridge are required. If additional
cartridges are installed and they are not needed for the current print job, the
printer interface indicates which are being used:

* Blue cartridge—used for the print job
» Gray cartridge—not used for the print job

You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button on the printer interface
screen.
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Sll'atasys 19012015 18:33

Temperature
behind print
plock o2 e |
L .~ Temp. of each
Temp. in front of | 62 “

block
ock 1 Support/Model

wassvoos EDEICIEICICICICY  Ponoupase
Waste (ar) 9000 block reservoir

| Ambient(°C) 43 Heads Vacuum 12.2 "“---__‘___
Chamber temp. = —= —_
P UV Lamps L . R Pre Heater 62 ~——System vacuum
I \ level
/ |
Temp. of

Waste weight—

Left and right UV
lamps material
RS —— 1 5 N
Display toggle o — ) STRATASYS J750™ pre-heaters
button
Printer set to
offline mode
(red)

Figure 6-4 Printer indicators
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Printer
Interface
Color Key
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

» Green—suitable/ready for printing
For example, in Figure 6-4 on the previous page:
O Heads (°C)—The heads have reached the temperature required for
printing models.

O Ambient—The ambient temperature of the printing chamber is within
the acceptable range.

O Heads Liquid—The level of Model and Support material in the
print-block reservoir is OK.

O Heads Vacuum—The vacuum level in the system is within the
acceptable range.

O Pre-Heater—The Model and Support resins need to be heated before
being supplied to the print block. The temperature has reached the
acceptable range.

* Red—not suitable for printing (or indicates a warning)
For example, in Figure 6-4 on the previous page:

O Waste—The weight of the waste container is 9000 grams, more than
allowed when beginning a print job. ("Replacing the Waste Container"
on page 6-88.)

* Blue—not ready
For example, in Figure 6-4 on the previous page:
O UV lamps—The UV lamps are not on.
The color of the material cartridges displayed in the printer interface indicates
which cartridges are active for the current (or next) print job.

« Blue—active cartridges
» Gray—reserve cartridges

6-9



Stratasys J750 User Guide 6 Operating and Maintaining the Stratasys J750 3D Printer

Prir}ting The printer interface screen changes when you send a print job to the printer,
Indicators if the printer is on line:

» The mode changes from Pre-print to Printing.

« The specific activity being performed is shown in the “current activity”
field.

« Current job-printing information is displayed.

« The printing progress bar is displayed.

 The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

19 Oct 2015 18:33

Cabinet A Cabinet B
VeroBlue  VeroBlue FullCure705 FullCure705
Printer mode | | | |
M3-L M3-R SH-L SH-R

foommee—r 400 gr 500 gr 500 gr
VeroCyan VeroCyan V(_arnllla_ck Veraﬂla_ck

Job information

M2-L M2-R M6-L M6-R

Current activity =
ADDgl: 400 gl: 400 gr 400 gr

: Slice 163 of 1013 (16.1%) VeroClear  VeroClear VeroYellow VeroVellow

Job information =
M1-L M1-R M5-L M5-R

Previous job last slice: 163
400 gr 400 gr | 400 gr 400 gr
FullCure705 FullCure705 VeroWhite  VeroWhite
SL-L SL-R M4-L M4-R 1

Progress bar
500 gr 500 gr | [ 200 gr 400 gr

STRATASYS J750™

Stop button Pause button

Figure 6-5 Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, the print manager stops sending slices
to the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you do not replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the print manager (in PolyJet Studio or in GrabCAD
Print).

After printing stops, the printer goes into Standby mode, when heating of the
print heads is reduced. About 10 hours later, the printer goes into /dle mode,
when heating of the print heads is stopped.

To continue printing the model:

1.

DOC-08040 Rev. A

If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see Figure 6-3 on
page 6-4).

The button changes from red to green (see Figure 6-3 on page 6-4).

If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

In the Manager screen of PolyJet Studio, or in the GrabCAD Print screen,

click the Resume icon— or E]

In the job-preparation application, make sure that the correct slice
number is entered in the Resume dialog box.

Resume From Slice

Resume from

Figure 6-6 Resume From Slice confirmation in PolyJet Studio
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Print Job L.Impeller GrabCAD
Last printed shce 168
Resume printing by choosing a shce number

Slice number 163

Figure 6-7 Resume Print confirmation in GrabCAD Print

The correct slice number is the last slice printed plus one. This appears in
the printer interface and in the GrabCAD Print application.

Printer mode

Print Time 00:00:43

Height 5.29mm of 77.88mm

Slice 168 of 2782 (6.8%)

Previous job last slice Lastslice printed

Figure 6-8 Printer interface after interrupted printing

5. If, for any reason, the correct number does not appear in the dialog box,
enter the number and click OK.

You cannot continue printing the model if:

« The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Resume from Slice
confirmation dialog box.

« There was a relatively long interruption in printing, even if the “last slice”
and "resume from slice" indicators are correct. The part of the model
already printed may deform or shrink, and there might be a visible
difference between it and the newly printed part. The effects of a printing
stoppage on a model depend on the model size and structure, Model
material used, ambient temperature and the length of the stoppage.
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If you cannot continue printing:

1. Cancel the job in the printing application (PolyJet Studio or GrabCAD
Print).

2. Remove the partially printed model from the build tray.
3. Resend the job to the printer from the printing application.

O In PolyJet Studio, click iasls.

s
O In GrabCAD Print, click .

%{ You can stop printing from the printer interface or from the printing
application.

* After clicking the Stop button in the printing application, you can resume
printing from the printing application or from the printer interface.

* After clicking the Stop button on the printer interface, you can resume
printing only from the printing application.

* After clicking the Pause button in the printer interface, you can resume
printing only from the printer interface.
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Changing the Printing Material

Before producing models using a different type of printing material than is
currently installed, run the Material Replacement wizard to flush the print
block and feed tubes.

%{ When changing the type of Support material, run the Material Replacement
wizard and the Head Optimization wizard to ensure quality printing results.
(After changing Support material with the wizard, Head Optimization is
required before printing models.)

%{ You should carefully plan printing models with different Model materials to
avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are replacing
one or more Model cartridges.

The Material Replacement wizard suggests the best slot locations for placing
different material cartridges, based on the materials currently in the system.
This ensures minimum flushing of materials currently loaded.

To replace the printing material with the wizard:
1. Start the Material Replacement wizard from the Options menu.

Go to Tray Upper Position

Go to Purge Position 26 ,Marzll‘t‘.i 17:45
Wipe

Go To Head Inspection

linet A Cabinet B

Go to Tray Lower Position

Purge Sequence
M3-R SH-L

Pattern Test

Wizards

Built In Tests.., Ctri+Aft+B Head Filling Calibration

Maintenance Counters,., Mipe: Clraring

Collect Service Data fad Ueaning

UV Calibration

UV Lamp Replacement

Head Alignment
Previous job last slice: 0 Head Optimization

Load Cell Calibration

Shutdown

Figure 6-9 Starting the Material Replacement wizard
2. In the opening screen, click Next.

3. If the printer cover is not closed, a screen appears, prompting you to close
the cover. Confirm that it is closed and click Next.
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4. Choose the configuration for producing models:

3 6 materials
O 3 materials

Material Replacement Wizard
Printing mode
@ 6 materials (High Mix / High Quality)

17) 3 materials (High Speed)

Required materials

Tango+ hd |
VeroPureWht X |
VeroBlack ;
VeroCyan -
VeroMgnt -
VeroYellow o |

Support | FullCure705 2t |

I 4 Help ‘ |Advanced Settings...|

[¥| Both cartridges
[¥] Both cartridges
[¥] Both cartridges
[¥] Both cartridges
[¥] Both cartridges

[¥] Both cartridges

Material Replacement Options

Mote: Cartidge positioning in material cabinet is determined automatically,

) Full
2 Full
~) Full
~) Full
) Full

2 Full

@230 4 carridges

'Full' provides you with exact color immediately.
'Economy’ enables a faster material replacement cycle.

@ Economy
@ Economy
@ Economy
@ Economy
@ Economy

@ Economy

x Lancel

Mext g |

Figure 6-10 Material Replacement Options

6 Materials

Each of the three Model print heads is loaded with two different

materials.

Support Support TangoPlus VeroWnite
S S M6 M5
| 1 | | # |
L

|
Support print heads

M4 M3
=0

|

VeroYellow
M2 M1
L+ |
]

Model pr1'|r1t heads

Figure 6-11 Six materials loaded in the print heads

O Once the materials are loaded, you can print with any single material,
or with a combination of them. High-speed printing is not available,
but high-quality models can be printed.
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3 Materials
Both sections of eachModel print head are loaded with the same material.

Support Support VeroWhite VeroWhite VeroYellow | VeroYellow
S S Mé M5 M4 M3 M2 M1
S - o il - bt

| L | ]
Support print heads Maodel print heads

Figure 6-12 Three materials loaded in the print heads
O Up to three Model materials are available, with high-speed printing.

. In the Required materials section of the wizard screen, select one or more

replacement materials cartridges.

. For Model materials, select Both if you need to load two replacement

cartridges.

Loading one replacement cartridge is more economical because it
potentially requires less flushing of material currently in the system.
However, when one cartridge is not sufficient, loading two cartridges
enables continuous printing until the print job is completed. When one
cartridge empties and the other one is being used, you can replace the
empty cartridge with a new one.

. For Support material, select the number of cartridges to replace (2, 3, or

4).

Note: Atleasttwo Support material cartridges are required.

. If the color or mechanical properties of the first printed models are

unimportant, you can change the Model materials without flushing out
the current materials. To do so, continue with "Changing Model Materials
Without Flushing" on page 6-19.

. To flush out material currently in the system, choose the flushing cycle

that fits your needs:

%{ The default flushing cycle is the one used for the last material replacement.

DOC-08040 Rev. A

There are additional settings that you can select for special purposes (see
"Advanced Settings"). If necessary, click Advanced Settings before clicking
Next.

This cycle is also recommended when changing the type of Support
material.

O Economy. This cycle can be used when replacing a light-colored Model
material with a darker material (such as TangoBlack™ or VeroBlack™)
or if the exact color of the printed models is unimportant. Use this
cycle when replacing cleaning fluid with any Model material.
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The wizard flushes the system with the minimum amount of material
needed to ensure that models have the mechanical properties of the
new material.
O Full. Use this cycle when the printed models must have the exact color

of the new material.
The wizard thoroughly flushes of the feed tubes and print heads
needed for printing, based on your selections in the previous screens.

10. Click Next to begin the material replacement process in the printer.

The Cartridge positioning screen appears, showing you the new location
of all cartridges in the material cabinet.

COpITT

Cartridge Positioning and Process Progression

Insert the new matsrial carridge a& shown betow, and click "Stat "

Cabinet A | Cabinet B

® Lelt Right i R Left Righi

M3 VeroBlue v VeroBlue supot  FullCure705 & FullCure705

M2 VeroCyan 1] VeroCyan ME VeroBlack & VeroBlack

M1 VeroClear & Vowarioae M5 VeroYellow ¥ VeroYellow (@

Swppor  FullCure705 ¥ FullCure705 M4 VeroWhite ¥ VeroWhite v

This process wil take approximately 4 minules

Figure 6-13 Cartridges placement
Symbols:

¥ The correct cartridge is in this slot.
® No cartridge (or the incorrect cartridge) is in this slot.

“ The cartridge in this slot has insufficient weight to complete the material
replacement process.

% The expiration date of the cartridge in this slot has passed.

11. Replace material cartridges as necessary, according to the instructions in
the wizard screen.

12. Click Start.
13. Read the warning message, and click OK.

% If you continue, you must complete the material replacement process before
you can produce models. To replace material cartridges at another time, click
Cancel. If you continue (by clicking OK) and you do not complete the process,
you will need to run the wizard again before producing models.
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& Caution

e e
I N Wizard Completed
Printer's current configuration
M ® Left Right Left Right

i —_— M3 VeroMgnt VeroMgnt Support  FullCure705 FullCure705

M2 VeroWhite VeroWhite M6 RGD535 RGD535

M1 VeroYellow VeroYellow M5 VeroCyan VeroCyan
." Support  FullCure705 FullCure705 M4 RGD515 RGD515

Printing mode: High Mix / High Quality
| stratasys
i o Done

%
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Figure 6-14 Final wizard screen

14. Click Done to close the wizard.
The printer-control application is automatically updated, and the interface
displays the new material(s). The interface in the job preparation
application is also updated, and it displays the new material(s).

15. Inspect the area around the purge unit and clean it, if necessary.

Dispose of all material cartridges in accordance with all applicable laws and
regulations. If necessary, the cartridges can be disassembled for recycling. If
this is done, protect the person handling the cartridges from direct exposure to
uncured resins.

After changing the type of Support material (SUP705/706), you need to run
the Head Optimization wizard before printing models. See "Optimizing
(Calibrating) Print Heads" on page 6-43 .
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Changing Model Materials Without Flushing

You can change the Model materials without flushing. Use this option when
the color or mechanical properties of the printed model are unimportant.
To change Model materials without flushing:

1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection and click
Apply.

-
Material Replacement Wizard

Advanced Settings

Cariridge positioning:
) Automnatic slot selection (Recommended)

@ Manual slot selection

This selection applies to this use of the wizard only.

Optional settings:

|| Enable “flush again” options

Stra tasvs This selection applies to this use of the wizard only.

 Help [ <€ concel | [ apob 3 | ||

Figure 6-15 Manual slot selection

3. When the Material Replacement Options screen opens, select the Replace
materials without flushing check box and click Apply.

Material Replacement Wizard
Material Replacement Options
Printing mode:
@ & materials [High Mix{ High Quality)
3 materals {High Speed) u ! ,‘_
Required materials
Support | FullCure 705 = | | Both centridges
ME | VeroBlack =i ¥ Both cartndges
B £
M VeroYellow 83 ¢ Both carridges
M4 | VeroWhite =|  [¥ Both carridges
M3 | VeroBlue | ¥ Bath carndges
A M| VeroCyan ' [¥! Both carnidges
M1 | VesoClear i 7| Both cartridges
Support | FullCure705 - |7 Bath cartridgea
‘Full’ provides you with exact color immediately, e ____"-u-hhx
'Economy’ enables a faster material replacement cycle (l_ ¥ Replace materials without |h:shlr|1_,)
-\"—\—__\__ B
[ % Hep | |Advarced Setings. | [ X concat [ et

Figure 6-16 Replace materials without flushing
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4. In the confirmation message that appears, click Yes to continue.

i

| You have selected to replace the materials without
¥ running the Material Replacernent Wizard,

Mote that this bypass is not recommended and will not
flush the systern with the new materials.

Are you sure you want to continue?

Confirm @

Figure 6-17 Replace without flushing confirmation message

5. In the Cartridge Positioning and Process Progression screen, click Start.

aterial Replacement Wiard
Cartridge Positioning and Process Progression
It M fow makensl cartrcige ue shown below. snd cfick St
Cabinet A | Cabinet B
@ et ikl L R L R @. gt
m3 VeroBlue % VeroBlue FullCure705 FullCure7D5
M2 VeroCyan 4 VeroCyan VeroBlack VeroBlack
M1 VeroClear VeroClear VeroYellow VeroYellow
Suppert FullCure 705 FullCure705 VernWhite VeroWhite
L m—. 1
{ Sort.
Ritplacement progrias
= ]
2 bk | 26 Goncet | | < Brevious |

Figure 6-18 Cartridge Positioning and Process Progression screen

6. Read the Warning message that appears, and click OK to continue.

l 3 Beyond this point, selecting 'Cancel' or
== changing/remuoving any of the material cartridges will
abort the wizard and disable printing.
Resurning printing will cnly be possible after completion
of this Wizard.
Do not remove any material cartridges from the printer
during this process,

[ QK ] [ Cancel

’Warnl'ng @

Figure 6-19 Warning message
Material replacement begins.
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Advanced
Settings

Positioning
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The Advanced Settings dialog box enables you to configure the Material
Replacement wizard for special purposes. If necessary, click Advanced
Settings in the Material Replacement Options screen before clicking Next.

By default, Automatic slot selection determines the best slot locations for the
cartridges in the material cabinet, based on materials currently in the system.
This ensures minimum flushing of materials currently loaded.

Select Manual slot selection if—

« there is a special need to load cartridges in certain slot locations.
« you only want to change one of the cartridges in certain slot locations.

Some materials cannot replace certain other materials. If you attempt to do
so, the wizard notifies you.

To select the slots for the cartridges manually:
1. In the Material Replacement Options screen, click Advanced Settings.

2. In the Advanced Settings screen, select Manual slot selection, and click
Apply.

-
Material Replacement Wizard

Advanced Settings

Cariridge positioning:

_) Automatic slot selection (Recommended)

@ Manual slot selection

This selection applies to this use of the wizard only.
Optional settings:

|| Enable “flush again” options

Stra taS\/S This selection applies to this use of the wizard only.

[0 ] [ € Concel | [ ook | ||

Figure 6-20 Manual slot selection
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3. In the Material Replacement Options screen, select or clear the Both
cartridges check box for each slot, as required.

Note: When changing Support material, select at least two Support
material cartridge slots—one from A (either L or R) and one from B
(either L or R).

Materiaf Replacement Wizard
Material Replacement Options
Printing mode
@ & materiala (High Mix | High Quality)
3 materials (High Spead) & ! ’

Required materials

Support | FullCure705 od| | Both cantridges
L

ME | VeroBlack T|  [¥ Bothcartndges R @ Full Econamy
B = .
M5 | VeroYellow *| ¥ Both cartridges @ Full Economy
M4 | VeroWhite = [TBoth carridges |L * @ Full Economy
M3 | VeroBlue A ¥ Both canridges @ Full Ecanarmy
n M2 | VeroCyan =| [T Both cartridges | ¥ @Full ) Econamy
M1 | VemClear - [¥ Both cartridges @ Full Econamy
Suppaort | FullCure705 'I [T Both carindges |L ol
‘Full” provides you with exact color immediately.
‘Economy’ enables a faster maternial replacemant cycla || Replace malerials without flushing

| 7 Hep Advanced Sedlings.. | |_x ;ancal.. [ Heﬂr

Figure 6-21 Material Replacement Options (Advanced)

4. When a check box is cleared, a dropdown menu appears. Select L (left) or
R (right) to change the cartridge on the left or the right side only in that
location.

After clicking Apply, the Material Replacement Options screen appears, but
now, each material selection box corresponds to one of the cartridge levels in
the material cabinet.

Printing mode
() & materials {(High Mix / High Quality)

@ 3 materials (High Speed)

Required materials

Cabinet A | Cabinet B
L R L R

Support [Fullcurs705

MG | :

B [ﬁ (
M5 |VeroYellow Z|
M4 l

M3 [VeroBlack

M2 |

M1 [Fullcure720

Support | FullCure705

Figure 6-22 Manual cartridge placement
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Additional ' The flushing cycle you select in the Material Replacement Options screen
Flushing Cycles determines how thoroughly to flush out material currently in the system.
After selecting the Economy cycle and completing the wizard, you might
decide that you require a more thorough flushing, to ensure accurate model
color. Or, you may notice that printed models are not satisfactory because
they contain traces of the previous material. If so, you can flush out more
material, so that the next models will be printed with pure material.

To perform additional flushing cycles:

> In the Advanced Settings screen, select Enable "flush again" options and
click Apply.

-
Material Replacement Wizard

Advanced Settings

Cariridge positioning:

@ Automnatic slot selection (Recommended)

) Manual slot selection

This selection applies to this use of the wizard only.

Optional settings:

|¥| Enable “flush again” options

Stra taS\/S This selection applies to this use of the wizard only.

[ 2 Hep | [ < Cancel | [ appp 3> | 1

Figure 6-23 Enable flush again options selected

The Material Replacement Options screen appears, where you can select the
material(s) you need to flush again.
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Keeping the Printer in Idle Mode

DOC-08040 Rev. A

Between printing jobs, the J750 printer can be left unused for up to one
week. If the printer will not be used for more than a week, use the Shutdown
wizard to automatically perform the procedures that must be done before
turning off the printer (see "Shutting Down the Printer" on the next page,
below).

When the printer stops producing models, the printer software automatically
reduces the temperature of the print heads as follows:

After printing stops Mode Change in heating of print heads
first 15 minutes Standby 1 no change

next 1 minute Standby 2

after Standby 2 Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the interface
(see Figure 6-3, and Figure 6-5 on pages 6-4, and 6-10).

If, after printing a job, you know that the printer will not be used for 16
minutes or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into Idle mode:

> From the File menu (in the printer interface) click Exit.
Note: The printer remains in Idle mode until you open the J750 printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this mode—
with the cover closed—for up to a week. For longer periods, shut down the
printer by running the Shutdown wizard (see below).
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Shutting Down the Printer

You only need to shut down the J750 printer if it will not be used for a week
or more. Otherwise, the printer can remain on, in Idle mode.

%Z\ The Shutdown process flushes printing materials from printer components.
To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

To properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown wizard. Do not attempt to shut down
the printer by simply closing the computer interface (the printer-
control application), and never disconnect power to the printer
before completing this wizard.

& Caution

Not using the printer for an extended period without first running the wizard
can cause serious damage to print heads and other expensive printer parts.

Depending on the length of time the printer will not be used, you can choose
between a short shutdown procedure, and a more thorough procedure.

« Up to 30 days: The wizard empties the print block of Model and
Support material, to prevent leaks. This takes about 10 minutes.

« More than 30 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 75 minutes, and you must
be present to load cleaning-fluid cartridges when instructed.
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Shutdown
Wizard
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To run the Shutdown wizard:

Start the Shutdown wizard from the Options menu.

-
Shutdown Wizard

Shutdown Wizard

G | You can leave the printer in idle state for up to 30 days.
/ Use this wizard whenewer you want to shut down the
printer. Do not atternpt to shut down the printer by turning
o off the printer computer, and newver disconnect power to

the printer before completing this wizard.
‘When shutting down the printer, you hawve two options,
depending on the length of time the printer will not be
uged:
-Upto 30 days.

Stratasvs - Mare than 30 days.

| x Lancel |

Figure 6-24 Shutdown wizard, opening screen

. Click Next.

Select the option corresponding to the length of time that the printer will

not be used—less or more than 30 days.

Note: Before selecting More than 30 days, make sure that cleaning-fluid
cartridges are available.

-
Shutdown Wizard

Select Action
Shutclown the printer for:

@ Up to 30 days.

i Moare than 30 days [requires cleaning-fluid cartridges].

stratasys

4 Help Cancel = Previou Mext I
| 2 Hep | | X Cancel | | |

Figure 6-25 Shutdown options
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4. In the next screen, indicate whether or not the tray is empty and click
Next.

-
Shutdown Wizard

Check Printer

Confirm before continuing:

[ The build tray iz empty.

stratasys

| x Lancel | I* Previous |

Figure 6-26 Tray status screen

5. In the next screen, verify that the tray is empty and click Next.
The shutdown procedure begins.

-
Shutdown Wizard

Shutdown in Progress

__ ﬁ%} :

stratasys

| x Lancel |

Figure 6-27 Shutdown progress screen

6. Follow the instructions until cleaning is completed.
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7. When the final wizard screen appears, close the printer-control
application and shut down the printer computer.

" |
Shutdown Wizard
. Wizard Completed
* ' You may now shut down the printer computer and turn off
EE power to the printer.
% Brading | " Dare |
L

Figure 6-28 Final Shutdown wizard screen

8. After the printer computer shuts down, turn off the main power switch at
the back of the printer (see Figure 6-2 on page 6-3).
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Maintaining the Printer

Routine
Maintenance
Schedule
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Performing routine maintenance tasks is essential for getting satisfactory
results from J750 3D printers. Perform the tasks at specified intervals.

Frequency Task For More
Information
Before printing Clean the UV lamp lenses
Before / after printing Check the UV lamp overheating indicator. | See "UV Lamp
Check "on
page 6-32.
Before / after printing Routine cleaning of: "Cleaning the
- print heads Print Heads,
Roller and
* roller surface .
i Wiper" on
* Wiper page 6-34.
* build tray and surrounding area
Weekly Clean the purge unit waste collector. See step 12 of
"Cleaning the
Print Heads,
Roller and
Wiper".
Weekly Perform the Pattern test. See "Pattern
Test" on
page 6-32.
Weekly Restart the printer computer.
Weekly Clean the roller waste collector. See "Cleaning
the Roller
Waste Collector
and Inspecting
the Roller
Scraper" on
page 1.
Every 300 hours of Calibrate the UV intensity. See "Testing
printing (A reminder and Calibrating
message appears.) the UV Lamps"
on page 6-61.
Every 300 hours of Optimize the print heads. See
printing (A reminder "Optimizing

message appears.)

(Calibrating)
Print Heads" on

page 6-43.
Monthly, and after Check the alignment of the print heads. See "Aligning
replacing print heads the Print

Heads" on

page 6-40.
Monthly Clean debris from the Z-axis shaft with a

vacuum cleaner.
6-29
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Maintenance
Counters
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Frequency Task For More
Information
Monthly Inspect the exhaust system (duct, fan,
connections).
Monthly Calibrate the load cells. See

"Calibrating the
Load Cells" on
page 6-68.

Every 1500 hours of print- | Replace the waste-pump tubes. See "Replacing
ing the Waste-
Pump Tubes"
on page 6-69.

About once a year (as
necessary)

Replace the Vero PureWhite Material
Filter

See "Replacing
the Vero
PureWhite
Material Filter"
on page 6-73.

Every two years or every
3500 hours of printing

Preventive maintenance visit by service
engineer.

The printer computer application records the dates and frequency for each
maintenance task. You can display the Maintenance Counters screen from
the Options menu.

Go to Tray Upper Position F5

Go to Purge Position F&
Wipe F7
Go To Head Inspection Fa
Go to Tray Lower Position Fl0
Execute Purge Sequence Fd4

Pattern Test
Dynamic Nozzle test

Wizards *
Built In Tests... Ctrl+Alt+B

| Maintenance Counters.., |}
Collect Service Data F2 |

Figure 6-29 Selecting Maintenance Counters

If there is a maintenance task due, this is indicated on the main interface
screen.

2/ stratasys

Maintenance Required

Figure 6-30 Maintenance Required indicator
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If this indicator appears, you can display the Maintenance Counters screen by
clicking on it.

%{ The Maintenance Required indicator appears by default for most operator-
performed maintenance tasks. The check box under “User Warning” controls
whether or not it appears when a particular task is due.

& Maintenance Counters (Hours)

File  Units
Item Total Dated Warning Time User Warning
- St S I |
A~
Pt iz Due | 1003
l;l_pe!alol _l_-lair_llena.r_.l.ce
U Calibration | | |
Heads Cleaning '—| [ 7017 _| :—
HCU . | | | -
Pattern Test [ | | |
Roller Bath Inspection ' J | | i
‘wiper Cleaning ' _—| | T GE _| T ]
Head Alignment . | [mE || ]
Load Cell Caliration |5 [ [osem | [
Festart Computer J |
Blade Replacement
Winer Blade I | T | _ v
Roller Blade , | : 740 | Reset Fl -

Figure 6-31 Maintenance Counters screen

For maintenance tasks that are controlled by wizards, the dates and printing
times are reset automatically when the relevant wizard is run and completed
successfully. Manual maintenance tasks (for example, roller inspection and
wiper replacement) are reset by clicking the reset button in the screen.
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UV Lamp
Check

A heat-sensitive label is fixed to the UV lamp covers as a warning against
overheating. Its center changes from white to black if the temperature of the
cover reaches 65°C (150°F). If this occurs, do not use the printer, and call
your service provider. As a precaution, it is recommended that you check the
label before and after printing.

Marmal

Dverheating
problem

Figure 6-32 Heat-sensitive label on UV lamp cover

% If the UV lamp continues to overheat, and the temperature around the lamp

Pattern Test

DOC-08040 Rev. A

reaches 90°C (194°F), a heat fuse turns off the electricity to the power to the
UV lamp and the motors for the X, Y, and Z axes. In the unlikely event that this
occurs, the printer cannot be used until it is serviced by an authorized service
engineer.

The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the print
heads. Make sure, therefore, that you perform this test weekly, and whenever
you suspect a printing problem.

To perform the pattern test:

1. Make sure that the build tray is empty.

2. Prepare a sheet of pink paper—A-4 or Letter size.

3. In the printer, tape the pink paper to the surface left of the build tray.
4. Press F3, or open the Options menu and select Pattern Test.

P Perform Pattern Test?
2)

Figure 6-33 Pattern Test confirmation
5. If the build tray is not clear, click No in the following dialog box.
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This lowers the build tray, so that models on the tray are not damaged.

Confirm ﬁ

Is the build tray dear?
.__l-r) {If you dick 'NC', the tray will be lowered.)

[ Yes l [ Mo ]

Figure 6-34 Build tray (Z) level adjustment
The printer prints a series of lines on the test paper (see next figure).

Figure 6-35 Sample Pattern Test

6. Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area, indicates
that the quality of printing when producing models will be poor. If this is
the case, see "Improving Print Quality" on the next page.

Note: Acceptable model quality is subjective, and depends on the type and
scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.
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Improving
Print Quality

Cleaning the
Print Heads,
Roller and
Wiper
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If you suspect that print quality is poor, perform the pattern test (see "Pattern
Test" on page 6-32). If the results are poor, use the following procedure to
improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Purge Sequence, or press F4.

2. In the confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the wiper
removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see Cleaning the Print Heads and the
Roller on page 1).

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue left
on them.

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

> Optimize the print heads and replace faulty print heads, if necessary (see
"Optimizing (Calibrating) Print Heads").

Regular inspection and cleaning of the orifice plates on the bottom of the
print heads prevents print nozzles from clogging. Cleaning the roller and
wiper are also important for maintaining quality printing. A wizard adjusts
printer components to enable access to these key areas, and it guides you
through the cleaning procedure. To maintain the printer in optimum
condition, run the wizard after every print job, when you remove the model
from the build tray. This procedure takes about 20 minutes.

To clean the print heads, roller and wiper:
1. Prepare—
O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
O disposable cleaning gloves
O a supplied cleaning cloth or equivalent
O a mirror
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2. Start the Cleaning wizard from the Options menu.

File Options Help

Go to Tray Upper Position F5
Go to Purge Pesition F6
Wipe F7
Go To Head Inspection F&

Go to Tray Lower Position
Execute Purge Sequence

Pattern Test
Dynamic Nozzle test

Material Replacement
Head Filling Calibration

Wizards

Built In Tests... Ctrl+Alt+B

Maintenance Counters.., Clunlngkn
Collect Service Data UV Calibratton
UV Lamp Replacement

s = Head Alignment
Previous job last slice: 0 Head Optimization
Load Cell Calibration

Shutdown

Figure 6-36 Options > Wizards menu

3. Make sure that the build tray is in the printer, and close the printer doors.
Confirm this in the wizard screen and click Next.

Cleaning Wizard

Check Printer

Caonfirm before continuing:

[T Tray is empty
[T Cover is closed.

stratasys
X Cancel <% Previous | | Newt 2>

Figure 6-37 Preparation check
The printer moves components to the cleaning position.

4. When the following screen appears, open the printer.

Cleaning Wizard

Check Printer

Caonfirm before continuing:

[ The print heads are clean.
[7] The roller was manually rotated and cleaned,
[7] The wipes blade is clean

stratasys
X Cancel <% Previous | | Newt 2> |

Figure 6-38 Wizard screen during cleaning tasks
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Warning: Hot Surface

b The print head orifice plates (bottom surface) may be hot. Do not touch them
with your bare hands, and proceed with caution.

5. Place the mirror on the build tray.

6. Put on the gloves.

Caution

Uncured printing material on the print heads might cause skin irritation. Use
disposable cleaning gloves to protect your hands.

7. Soak the cleaning cloth with alcohol.

8. Clean the orifice plates, with a back-and-forth motion. Use the mirror to
make sure that you have removed all of the residue material.

Figure 6-39 Cleaning the heads

9. After cleaning the print heads, clean the entire roller surface, by rotating it
as you clean.

10. Clean the glass lens on the UV lamps.

11. Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.
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12. Remove any pieces of waste material collected in the purge unit. If
necessary, remove the waste collector to clean it. Wipe the rubber seal.

Figure 6-40 Purge unit waste collector

Note: When returning the waste collector to the purge unit, make sure to insert it
as shown.

13. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

14. When you have finished cleaning, select the confirmation check boxes in
the wizard screen (see Figure 6-38) and click Next.

15. Remove the cleaning materials from the printer and close the printer
cover.

16. Select the confirmation check boxes in the wizard screen and click Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Cleaning Wizard

Wizard Completed

stratasys

7 Cancel | = i‘-e‘-'.-'u-uu':| " Done

Figure 6-41 Cleaning wizard—final screen

17. Click Done to close the wizard.
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Replacing the  you should replace the roller scraper blade—
Roller Scraper .
« after 1,000 hours of printing.

« if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See "Cleaning the Roller Waste Collector and
Inspecting the Roller Scraper" on page 1-1.

To replace the roller scraper:

1. Prepare—
O anew roller scraper blade (KIT-01026-S)
O a Phillips 1x75 mm screwdriver
O M2.5 and M2 Hex (Allen) keys

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 1-1).

3. Loosen the two screws securing the roller waste collector and pull it out.

Figure 6-42 Removing the roller waste collector

4. Remove the screws that secure the roller scraper assembly.

Figure 6-43 Removing the roller scraper screws

5. Remove the scraper blade and discard it.
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Figure 6-44 Removing the old roller scraper blade

6. Place the new scraper blade onto the pins in the holder, as shown.

joval hole

5] I‘:lgd‘ﬂ':l
{round hole
In b{-‘gdﬁ i |
ey

Figure 6-45 Inserting the new roller scraper blade
7. Insert and tighten the roller scraper blade screws.

Important:

« Tighten the screws in the order shown in Figure 6-46.
« Use the new screws supplied in the replacement kit

B

Figure 6-46 Tightening the roller scraper screws
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Aligning the
Print Heads
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8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to the
print block. (See steps 4 to 6 on page 1-1 in "Cleaning the Roller Waste
Collector and Inspecting the Roller Scraper".)

You should check the alignment of the print heads—
 once a month
« after replacing one or more heads

« if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see "Cleaning the Print Heads, Roller and
Wiper" on page 6-34).

This procedure takes about 20 minutes.

To check the alignment of the print heads:
1. Prepare—
O atransparency sheet—A-4 or Letter size

O any type of adhesive tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment wizard from the Options menu.
3. Click Next to begin, and close the cover.

4. In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

5. When instructed to do so, place the transparency on the build tray— next
to the left and rear edges of the tray, as shown in the following figure.

Figure 6-47 Positioning the transparency on the build tray
6. Make sure that the transparency sheet is lying flat, and tape it to the tray.

7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.
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8. When the following screen appears, remove the transparency.

-

-
Head Alignment Wizard

Check Printer

Confirm before continuing:

[ The transparency is secured to the build tray.

stratasys

4 Help Cancel
[ 2beb | [ % Corcel |

e

Figure 6-48 Head Alignment wizard—steps 8-10

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

Print Head Numbers
HO H1 : H2 : H3 : H4 !-Iﬁ HE :
|'|'|i I|||| IIJIIIJi II||| ]ulu |.'|';' |||” ”IIII |I|IHL|I|| |”H I|'||| I|'r||| ||r|I
IIlII:IHII |||'||1'“|I| ’.'..I.'.':' |||””|||| IIIIH:III' I“II IIIIIJ |||l||:“r||
IIlIIIIIIII IIIIIIIHIII 1|I||”|I:I IIlll”lllI IIIIH:IIII IHIIIIIIIIF IIltlllllilI
|||I|II||I| |':'|'I”|'| 1|'|r||'|';J I||||H|I|I lllllrltllll I”IIIIIIII1 IIIEIIIIIEII
g ml' Yl Yl T LT

Figure 6-49 Sample head-alignment test

Note: Thereis no column for head H7 because its alignment is used as a
reference for aligning all other heads.

. For each column of lines, use a magnifying glass or loupe to inspect pairs

of consecutive rows printed on the transparency to see where the vertical
lines align.

1234567
S\ AT

NRERRN
[ I|I|II |I|I|I ]
[ NN ]
[IllllI |I|I|I

Figure 6-50 Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)
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Optimum head alignment is shown when the fourth lines in the upper and
lower rows are aligned, as in Figure 6-50. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment of that head—in the next
wizard screens.

10.In the wizard screen shown in Figure 6-48, select the Transparency
removed check box, and click Next.

The first in a series of alignment screens appears.

-
Head Alignment Wizard

1234567 Head 6
] lf{'.//
[T
(NERNAN
[T
(RN NER
[EAARN 1 2 3 4 5 & [

NRRREN @] @ °

Selectthe number representing the aligned lines
on the transparency.

stratasys
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Figure 6-51 Head alignment screen

11. In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

12. Click Next to display the next head alignment screen, and again select the
number representing the most closely aligned vertical lines on the
transparency for that print head.

When you have finished aligning all of the heads, the following screen is
displayed.

-
Head Alignment Wizard

Select Action

@ Lpdate spstem with new parameters,

i Keep previous parameters.

stratasys
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%

Figure 6-52 Parameter update confirmation
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13. Continue as follows:

O To make the alignment changes in the printer, make sure that Update
system with new parameters is selected, and click Next.

O To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

O If you do not want to make alignment changes in the printer at this
time, select Keep previous parameters and click Next.

14. In the following screen, you can choose to either repeat the head
alignment procedure or close the wizard.

The transparency test will show if the heads are now properly aligned,
and—if not—the wizard will allow you to “fine tune” the alignment.

O If the vertical lines for the print heads were not aligned at either
extreme, choose End the wizard, then click Next.

i Head Alignment Wizard 1
Select Action
@ Repeat the test and print anather transparency.
1 End this wizard.
stratasys
| ? Help | | x Lancel | |~(Erevious| | st - |

Figure 6-53 Repeat head alignment option

The condition of the print heads directly affects the quality of printed models.
To maintain optimum printing, you should routinely test the print heads, and
calibrate them to the best working configuration possible by running the
Head Optimization wizard every 300 hours of printing.

During this procedure, you place a scale on the build tray and connect it to
the printer. Printing material (resin) is jetted from each head and its weight is
automatically recorded and the wizard determines how to optimize the print
heads.

If, during the optimization process, the wizard determines that a print head is
faulty—or that it is negatively affecting layer uniformity with the current head
configuration—the wizard instructs you to replace it. If this happens, you can
continue the wizard to replace the print head, or abort the wizard, to replace
the head at another time.

Run the Head Optimization wizard whenever the condition of print heads is

negatively affecting the quality of printed models, or if you suspect that there is
a problem with one or more of the print heads.

Note: To accurately test and calibrate print heads, they must be clean. If
necessary, run the Head Cleaning wizard before beginning this procedure.
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To test and calibrate the print heads:

1.

O pink paper

Go to Tray Upper Position
Go to Purge Position
Wipe

Go To Head Inspection
Go to Tray Lower Position

Purge Sequence
Pattern Test

Wizards
Built In Tests...

Maintenance Counters..,
Collect Service Data

Previous job last slice: 0

O disposable cleaning gloves (any clean, powder-free protective gloves)

O the Missing Nozzles ruler

O the scale supplied for use in the Head Optimization wizard

Important: Ensure that the scale is calibrated and charged before
beginning this procedure. It is highly recommended to connect the scale
to the wall power socket when running this wizard.

Start the Head Optimization wizard from the Options menu.

26 Mar 2015 17:45

Material Replacement
Head Filling Calibration
Wiper Cleaning

Head Cleaning

UV Calibration

UV Lamp Replacement
Head Alignment

Load Cell Calibration
Shutdown

Figure 6-54 Starting the Head Optimization wizard
In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.
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5. In the following screen, select Continue with Head optimization if you have

recently cleaned the print heads. Otherwise, cancel the wizard and run the

Head Cleaning wizard.

-
Head Optimization Wizard

Select Action

Ifywou are not sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

(1 Cancel this wizard to clean the heads first.

@ Continue with Head O ptimization.

stratasys

| X Cancel | I(Ereviqus‘[ Mext J

L

Figure 6-55 Clean print heads screen

. In the following screen, make sure Optimize all print heads is selected,

and click Next.

-
Head Optimization Wizard

Select Action

@ Optimize all print heads.

i Replace faully heads and optimize all heads.

stratasys
2 Help X Cancel | Mext :

Figure 6-56 Procedure selection screen

and click Next.

Select Action

(1 High Speed/High Mix

11 High Guality

stratasys

x Lancel |

Figure 6-57 Printing mode selection

7. Select the printing mode for which you want to optimize the print heads
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8. When the following screen appears, tape a sheet of pink paper to the
surface left of the build tray, close the cover and click Next.

-

-
Head Optimization Wizard

Check Printer

Confirm before continuing:

[ The build tray is empty,

— [7] The cover is closed.

stratasys

| x Lancel | I( Erevio_us‘ Mewt 2= W

Figure 6-58 Preparations confirmation
The printer prints a frame on the build tray and then prints the Pattern
Test.

9. When the Pattern Test is printed, carefully inspect it, using the Missing
Nozzles Ruler to see if there are missing lines.

Print Biock &

Frant of Pravier §
Figure 6-59 Inspecting the Pattern Test
Each missing line represents a faulty nozzle in the print head.

10.In the following wizard screen, enter the number of missing nozzles for
each print head and click Next.

Enter Missing Nozzles

Open the cover and remove the pattem test paper.
Enter the number of mizzing nozzles for each head below.

a a a a a a a a
Head 0 Head 1 Head 2 Head 3 Head 4 Head 5 Head 6 Head 7

stratasys
2 Help X Cancel |

Figure 6-60 Enter Missing Nozzles screen
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11. The wizard continues according to the number of missing nozzles you
entered.

O If there are too many missing nozzles for acceptable printing, the
wizard instructs you to replace the defective print head(s). You can do
this now, or abort the wizard.

If you are prepared to replace print heads now, the wizard guides you
through the procedure when you click Next. Make sure you have
replacement heads and the required tools (see "Replacing Print Heads"
on page 6-50). Continue with "Preparing the Print Block" on page 6-
52.

'Head Optimization Wizard

Error: High Missing Nozzle Count

Head & defective.

@ Replace defective heads).

(7 Abort wizard.
stratasys
| ¢ Help X Cancel <% Previous Mest g |

Figure 6-61 Head replacement due to missing nozzles

O If the number of missing nozzles in all print heads is acceptable, the
wizard continues with the head optimization process (below).

12. Set up the scale in the printer by performing the steps listed in the wizard
screen.

Prepare Scale

Ferfarm the steps in the order below and confirm:

[ Pasition scale on tray and connect cable ta prirter
[ Press ' to turm on the scale [without the container).
[ Wit for the scale to display '0.00%

[T Place the container on the scale

[ Press 'T' to zero the scale with the container

[ Close the printer cover.

stratasys

| 2 Help | X Cancel |

Figure 6-62 Setting up the Head Optimization scale
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13. After confirming all of the items listed in the wizard screen, click Next.

Printing material (resin) is jetted from each head and its weight is
automatically recorded. This process is repeated for each printing mode,
after which the following screen appears.

[ - 5
ﬁ' e

Empty the Resin Container

Ferfarm the following:

[ Empty contairer inta purge unit,

[ Returr the container to the scale:

[] Cloge printer cover.

stratasys

| x Lancel |

Figure 6-63 Emptying the resin container

14. Carefully remove the resin container from the scale and empty it into the
purge unit in the printer. Then return the container to the scale.

& Caution: The resin in the container is uncured

« To prevent contact with skin, wear neoprene or nitrile gloves.

« Dispose of uncured resin in accordance with applicable regulations. By
emptying the container into the purge unit, the resin is stored in the printer's
sealed waste container.

15. Close the printer and click Next.
The printer cures the remaining resin in the container.

16. When the following screen appears, remove the scale and clean the build
tray.

Head Optimization Wizard

Remove Scale

Confirm before continuing:

[7] The scale and cable are removed.
[ The build tray is empty and clean.

|7 The cover iz closed.

stratasys
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Figure 6-64 Remove the scale confirmation screen
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The wizard uses the data collected to analyze the condition of the print

heads and optimize them so they print models with a uniform layer of
material.

O If the heads are in satisfactory condition, the following wizard screen
appears.

| Head Optimization Wizare
L nizatio

|

Wizard Completed

Click 'Done’ to restart the printer application.

stratasys

Figure 6-65 Final wizard screen, after optimizing print heads

O If the wizard determines that a print head is faulty—or that it is
negatively affecting model quality with the current head

configuration—you need to replace it. Indicate whether or not you
want to do so now.

'Head Optimization Wizard
Weight Test Results

Head & defective.

@ Replace defective head(s):

(71 Abort wizard,

stratasys
| ¢ Help X Cancel | <2 Previous Mest g |

Figure 6-66 Defective print heads found

O Choose Replace defective head(s) if you are prepared to replace the
print heads now (see below).
or—

O Choose Abort wizard if you want to replace the print heads at another
time.

%( Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.
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To replace print heads, you need these tools and materials:
O replacement print head(s)
O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

O disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

a supplied cleaning cloth or equivalent
a mirror
a 3 mm hex (Allen) key (depending on the type of print block)

aaaaqn

the scale supplied for use in the Head Optimization wizard (Weight
Test)

O the Missing Nozzles ruler

If you are replacing print heads now, the wizard guides you through the
procedure when you click Next. Continue with "Replacing Print Heads"
below.

Replacing The condition of the print heads directly affects the quality of printed models.
Print Heads You may need to replace a print head if one or more of the following
symptoms occurs:

» The Head Optimization wizard determines that a print head is defective.
(See "Optimizing (Calibrating) Print Heads" on page 6-43.)
« There are noticeable grooves in the surface of printed models.

« Visual inspection of the head reveals that its surface is damaged—peeling
or bubbles in the nozzle area.

« The printer interface displays a warning or malfunction message relating
to a print head—

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

%{ Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.
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The Head Optimization wizard guides you through the procedure of replacing
a print head, and adjusts printer components to enable you to perform it.

Only replace a print head with the aid of the wizard. The entire procedure
takes about 45 minutes, and consists of the following phases:

A.

=

T H D0

Identifying the head(s) needing replacement.

This is normally done by the Head Optimization wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction message
indicates which head needs replacing.

Preparing the print block for head replacement.
This is done automatically when you run the wizard.

Removing the defective print head.

. Installing a new print head.

Optimizing the print heads (done automatically by the wizard).

Performing head alignment.

To replace a print head:

1.

DOC-08040 Rev. A

Prepare—
O replacement print head(s)
O isopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)

O disposable cleaning gloves (supplied with the print head; or use any
clean, powder-free protective gloves)

a supplied cleaning cloth or equivalent
a mirror

a 3 mm Hex (Allen) key, depending on the type of print block

aaaaqn

the scale supplied for use in the Head Optimization wizard (Weight
Test)

O the Missing Nozzles ruler
Important: Make sure that you have these items and that the scale is

calibrated and fully charged before continuing. It is highly recommended to
connect the scale to the wall power socket when running this wizard.

Start the Head Optimization wizard from the Options menu (see Figure 6-
54 on page 6-44).

In the opening wizard screen, click Next to begin.

The Wizard Conditions screen appears.

Read the conditions, select | Agree and click Next.
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5. In the following screen, select Continue with Head optimization if you have
recently cleaned the print heads. Otherwise, cancel the wizard and run the
Head Cleaning wizard.

-
Head Optimization Wizard

Select Action

Ifywou are not sure that the heads are clean, cancel
this wizard and run the Head Cleaning wizard first.

(1 Cancel this wizard to clean the heads first.

@ Continue with Head Optimization.

stratasys
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Figure 6-67 Clean print heads screen
6. In the following screen, select Replace faulty heads, and click Next.

-

-
Head Optimization Wizard

Select Action

(1 Dptimize all print heads,

@ Feplace fauly heads and optimize all heads.

stratasys
| 2 Help | X Cancel | <75 Previou: Mext I

L

Figure 6-68 Procedure selection screen
Preparing the 7. Select the print head(s) needing replacement, and click Next.
Print Block . .

Head Optimization Wizard

L Select heads to be replaced

Head 041 Head 2-3 Head 4-5 Head £-7

stratasys

|= x Lancel ] I~( Previous |

L

Figure 6-69 Head selection screen

The printer heats and empties the print block, and prepares the printer.
(This should take up to 15 minutes.)
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8. The following screen appears when the printer is ready for you to replace
print heads.

Head Optimization Wizare
Print Head Replacement

The printer is ready foryou to replace print heads.
Click 'MNext' to continue,

stratasys

x Lancel |

| S
Figure 6-70 Printer ready for head replacement

9. Put on the protective gloves and open the printer cover.

Note: The printer disconnects power to the heads for your safety.

10.On the print block, release the upper and lower screws that secure the
print head in the block. (If necessary, you may use a Hex (Allen) key to
loosen the screws.)

Removing the
Defective Head

Figure 6-71 Releasing the locking screws
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11. Press down on the upper and lower locking screws to release the print

head.

Figure 6-72 Releasing the print head
12. Loosen the screws on the door of the compartment protecting the
print-head driver cards (A), then pull and lift up the door (B).

’ 8 g £
Ik ¥
B + 7|
o |
N 4% o |
-y
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; ~ A
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Figure 6-73 Opening the print-head compartment
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13. Loosen the clips and pull the print-head driver card out of its socket so
that the head is free (A), and remove it from the bottom of the print block

(B).

Figure 6-74 Releasing the print-head driver card to remove the head

14. Make sure that along with the head, you remove the two rubber O-ring
seals.

Figure 6-75 O-ring seals on the print head

%{ Important

If the seals are not removed with the head, they are probably stuck to the print
block housing. If so, remove them.
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Figure 6-76 Making sure the O-rings are not stuck to the print block

15. Inspect the replacement head, and make sure that the O-ring seals are in

Installing th
neaind M® ™ Dlace (see Figure 6-75 on the previous page).

New Head
16. Gently insert the replacement head into the vacant slot in the print block,
and push the print-head driver card into its socket.

Note: Make sure to insert the head with the driver card facing its socket, in the
rear of the print block.

.‘Jtl,,:gﬁ

Figure 6-77 Inserting the print-head driver card into its socket

DOC-08040 Rev. A 6-56



Stratasys J750 User Guide 6 Operating and Maintaining the Stratasys J750 3D Printer

17. Push the head up. Use a mirror to make sure that the location pins are in
place.

i

Figure 6-78 Pushing the head into place in the print block

18. Lower the door of the print head compartment, and tighten the screws to
lock it in place.

19. Tighten the upper and lower screws that secure the print head in the print
block (see Figure 6-71 on page 6-53).
Note: Hand-tighten these screws. Do not use a screwdriver.

20.In the Replace print heads screen, select the check box to confirm that
you have replaced the head(s), and click Next.

| . ||

Replace print heads

Feferto the instructions included in the head
= replacement kit, or click 'Help'. Canfirm:

xd 7| Head O replaced
HO-1 H2-3 H4-5 He-T r_ 5

stratasys
I 2 Help ] [ Wiew Movie I | x LCancel | <& Praviou Hest J I
E 4

Figure 6-79 Head replacement confirmation
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21. With your fingers, make sure that the new head is level and even with the
other heads.

S
| _—aw
:;": '\:T’“"i __.-}

i S .;;\I y

Figure 6-80 Checking the level of the new head

Head Optimizatio_gf

22.Confirm that the heads are level by selecting the check box in the
following wizard screen, and click Next.

Installation Check

[T Done

Check thatthe print heads are level and even.

stratasys
| x Lancel ‘ [{ Erevio_us‘
Figure 6-81 Installation-check screen

23.In the next wizard screen, confirm that you have removed all tools and
objects from the printer.

Check Printer

Confirm before continuing:

[ The build tray is empty.

[T The cover iz closed.

stratasys

| X Cancel ‘ [*( Erevio_us‘

Figure 6-82 Cleared-tray confirmation screen
24.Close the printer cover.
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The wizard continues by heating the heads, then filling and purging them.
If there are no installation problems, the optimization procedure begins,
to calibrate the print heads to the best working configuration—
"Optimizing (Calibrating) Print Heads" on page 6-43.

If installation problems are detected, the wizard alerts you and instructs
you how to continue (see "Installation Problems", next).

25.After replacing print heads, you should check the head alignment before
using the printer to produce models. In the final wizard screen:

O Select Optimize all print heads and click Next. Run the Head Alignment
wizard.

Select Action

@ Optimize all print heads.

i Replace faully heads and optimize all heads.

stratasys
2 Help

Figure 6-83 Final wizard Screen
Installation  1f the printer detects that there is a problem after you install print heads,
Problems  relevant warning screens appear.

« If the printer software does not detect the replaced head, the following
warning screen appears.

Head Replacement Wizard

One or more heads
not inserted correctly

Remaove and re-insert the driver connector(s)

stratasys
? Help x Lancel | Q% Previo:

Figure 6-84 Incorrect-installation screen
If this happens:
a. Open the print head compartment (see Figure 6-73 on page 6-54).

b. Re-insert the print-head driver card into its socket (see Figure 6-77 on
page 6-56).

c. In the wizard screen, select the check box to confirm that you have
re-inserted the card, and click Next.
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« If the replacement head was not factory-calibrated, the following warning
screen appears.

Head Replacement Wizard

Inserted head does not contain

factory data
\ The installed head does not contain valid data, Try
replacing it with another head. Ifthis does not
succeed, contact Customer Support.
S
[T Atternate print head installed.

P Help

Figure 6-85 Invalid-data warning screen
If this happens:

a. Remove the head and replace it with another one (starting with step 10
on page 6-53).

b. In the wizard screen, select the check box to confirm that you have
installed another print head, and click Next.

c. Contact your authorized Customer Support center about the
unformatted head.

« If the vacuum test is not successful, the replacement head was not sealed
properly during installation, and the following warning screen appears.

Head Replacement Wizard

Vacuum leakage detected!

Avacuum leakage was detected. The next steps will guide
wau through the procedure for re-installing the head(s),

stratasys
? Help K Cancel | =L Previous | i M

Figure 6-86 Vacuum-leakage warning screen

If this happens:
a. Click Next.
b. Follow the instructions on the wizard screens to re-install the head.
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Testing _and The level of UV radiation from the lamps used for curing models can change

Calibrating the  over time. To ensure optimum curing of models during printing, a pop-up

UV Lamps message reminds you to test the lamps and calibrate the level of UV radiation
after every 300 hours of printing. You do this by running the UV Calibration
Wizard.

To measure the UV radiation, you need:
« Stratasys TOL-03005-S (UV sensor and cable)
or—
« a stand-alone UV radiation meter, approved for use with the printer
The wizard compares the measured radiation to the recommended radiation

level for each of the lamps, at each printing mode—High Speed, and High
Quality and Digital Material.

When calibrating the lamps, the wizard attempts to adjust the radiation level,
if necessary.

« If the reading is within the acceptable range, the wizard continues to the
next phase.
« If further adjustment is necessary, the current phase is repeated.

« If the level of UV radiation is too low to be properly adjusted, the wizard
continues to the next phase, but the final wizard screen indicates that the
lamp’s radiation for the printing mode is unacceptable.

% Before testing and calibrating the UV lamps:

« Make sure the glass lens on each of the UV lamps is clean. For easy access,
run the Head Cleaning Wizard, and use the special cleaning pad supplied.

« Make sure that the glass over the UV radiation sensor is clean.

To test and calibrate UV lamp radiation:
1. Start the UV Calibration Wizard from the Options menu.

2. In the following screen, select Calibrate UV Intensity to adjust the lamp’s
radiation level to the acceptable range.

i UV Testing/Calibration Wizard 1
Select Action
1 Test UV intengity
@) Calibrate LV intensity
1 Calibrate UV senzor box [Support use only]
stratasys
| 2 Help | | X Cancel | =P L | Mext |

Figure 6-87 UV Test/Calibration selection
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3. In the following screen, select the UV sensor and measuring device to be

used.

-
UV Testing/Calibration Wizard

Select Device

@ LIV zenzor box

(0 1 external radiation meter

stratasys

| x Lancel |

Figure 6-88 UV device selection

%{ UV Measuring Device

When you use the Stratasys UV sensor box (TOL-03005-S), you connect it to

the printer. The wizard automatically measures and calibrates the UV

radiation.

If you use a stand-alone UV radiation meter, you need to manually enter the

readings from the meter in the wizard screens.

4. Make sure that the build tray is empty. Confirm this in the wizard screen

and click Next.

-
UV Testing/Calibration Wizard

Check Printer

[j Confirm before continuing:
. [ The build tray iz empty.

stratasys

| x Lancel |

Figure 6-89 Printer preparation

> When using a Stratasys UV sensor box that you connect to the printer

(TOL-03005-S), continue with "UV Sensor Connected to Printer" on the

next page.

> When using a stand-alone UV radiation meter, continue with "External

UV Meter" on page 6-65.

DOC-08040 Rev. A
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UV Sensor The following steps apply when using the Stratasys UV sensor box that you

Connecte}d to connect to the printer. They do not apply when using a UV external radiation
Printer measuring device.

1. To synchronize the wizard and the UV sensor, enter the CF number from
the label on the back of the UV sensor box and click Next.

[ |
UV Testing/Calibration Wizard

Synchronize the wizard and the
UV sensor

Enter the CF number printed on the LY-gensor label.

stratasys

| X Cancel | <& Previou Mewt e I

Figure 6-90 UV sensor synchronization

L

f Stratasys®

S L A

UV SENSOR

gm: iyAFuEoeasy

CfF: ;-";_}"2

Calibration date: _t.‘I.hJJ.lf_

e

Figure 6-91 Label on the bottom of the UV sensor box
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The build tray lowers so you can connect the UV sensor box.

Figure 6-92 UV sensor connector

2. Connect the UV sensor cable to the connector in the printer.

To ensure that the sensor cable does not interfere with the build tray when it is
raised, route it in back of the sensor.

[ |
UV Testing/Calibration Wizard

X Place Sensor

Confirm before continuing:

[ The UY sensor bo is connected to the printer.

| The U zensor box iz positioned on tray as shown;

|| The glass in the UV sensor bo is clean.

[ The sensor cable is secured ta the tray.

| The printer cover is closed.

stratasys

| x Lancel |

L

Figure 6-93 Sensor preparation
3. Confirm the items listed in the wizard screen and click Next.

Continue with "UV Measurement " on page 6-66
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External UV The following steps apply when using a stand-alone UV meter. They do not
Meter apply when using the Stratasys UV sensor box connected to the printer.

1. When the following screen appears, open the printer and place the UV
sensor box at the rear edge of the tray, in the center.

-

-
UV Testing/Calibration Wizard

Place Sensor

Confirm before continuing:

[ The UV sensor is in the center of the tray's far edge.

[ The sensor cable is routed ta the front of the printer.

stratasys

4 Help Cancel
[ 2beb | [ % Corcel |

Figure 6-94 Sensor placement screen

2. Lead the cable out of the printer so that you can close the printer, and
tape it down to make sure that it does not interfere with the moving print
block.

Tape the cable to the build tray to keep it in place.

1
Figure 6-95 Correct UV-sensor placement

3. Close the printer, while checking that the sensor does not move out of
position.

Set the UV meter to measure mJ/cma2.

Set the range on the meter to 2,000.

Connect the cable from the sensor to the UV meter.

Turn on the UV meter, and wait until “0 0 0.0” appears on the display.

© N oo p

In the wizard screen, confirm that the sensor is positioned correctly, and
click Next.

Continue with "UV Measurement " on the next page.
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uv
Measurement
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The UV lamps power up and stabilize. (This takes several minutes.) Then, the
print block passes over the sensor and the wizard compares the measured
radiation to the recommended level for each UV lamp and printing mode.
During this process, which takes 20—40 minutes, you need to monitor the
progress as displayed in the wizard screen.

-
UV Testing/Calibration Wizard

UV Intensity Measurement

;‘I % Currently reading  Right UV lamp in High Mix Mode

Lamp Initialization
| (~120sec.)

UY measurement

Overall progress

stratasys

| x Lancel |

L

Figure 6-96 UV measurement progress

When using a stand-alone radiation meter, reset the meter and enter the
reading (measurement) when you are prompted to do so.

Enter ¥alue E|

Enter U measurement device reading

value here, .,

| nker

[ Ok, H Cancel ]

Figure 6-97 UV Measurement dialog box
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If the UV level measured is not acceptable, the wizard calibrates the UV lamp

by adjusting the current supplied to it, and then tests it again.

When all UV tests have finished, the results are displayed, showing the
condition of the lamps after calibration (see Figure 6-98 below).

-
UV Testing/Calibration Wizard

HS o 1771 %[110%]
1495 1435

stratasys

| 2 Hep |

UV Calibration Results
Left UV Lamp Right U¥Y Lamp
HM S 2079 % [100%] S¢ 2002 % [100%]
5& 1495 -» 1495 3'6 1655 -» 1495
Hepkeslnn | oHeriack g
HQ .\‘é’ 140.4 % [80%] q/' 140.4 % [B0%]
© 1495 - 14595 © 1734 > 1455

o 154.0 % [130%]
© 1734 5 1495

terevoue | [ bon e ]

._

-

Figure 6-98 Results and condition of UV lamps after calibration

After examining the UV calibration results:

1. Click Next.

2. Remove the UV sensor and close the printer cover. After confirming the
items listed in the wizard screen, click Next.

f UV Testing/Calibration Wizard
N Wizard Completed
g Feplace the LW lamp(s).
Contact customer support.
stratasys
E st |m"|

Figure 6-99 Final UV Calibration Wizard screen

6-67



Stratasys J750 User Guide

6 Operating and Maintaining the Stratasys J750 3D Printer

Calibrating the
Load Cells

DOC-08040 Rev. A

Load cells are sensors that measure the weight of the material cartridges and
the waste container in the printer. It is important that you periodically check
that the weight measurements are accurate to prevent unnecessary waste of

printing materials. It is recommended that you calibrate the load cells once a

month.

To calibrate load cel

1. Start the Load Cell Calibration wizard from the Options menu.
2. In the following screen, select one or more load cells that you want to

calibrate.

Is:

-
Load Cell Calibration Wizard

stratasys

Select Load Cells to Calibrate

Remove each cartridge you selected from the cabinet,

Cabinet A Cabinet B
NN ey
L L
[T waste CACH i,
5, 8, i,
| x Lancel |

L%

Figure 6-100 Load cell selection

3. Remove each selected cartridge from the materials cart, and click Next.

4. In the next wizard screen, observe the numbers and wait until the level is

relatively stable—two units above or below the average level shown.

-
Load Cell Calibration Wizard

stratasys

| 2 Hep |

Indicate when Values are Stable

“wiait 10 full seconds for the load cell value to stabilize.

Cabinet A Cabinet B
1163430 1164060 [116120 | o
162320 [1162900  [11RE360 [1167640

i 11611 (1165800 (1166380

1160000 [1160580 1164840 [1165220

7| values are stable

| x Lancel |

L%

-

Figure 6-101 L

evel stabilization

5. Select the check box, and click Next.
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6. Click Done in the final wizard screen.

-
Load Cell Calibration Wizard

N Wizard Completed
If you removed the waste container, replace it and ensure
that the drain tube is not bent.

T If, after calibrating the load cells, you suspect that they are
not accurately measuring the weight of the containers,
contact your local customer support representative.

o Done I

S

Figure 6-102 Final wizard screen

Replacing the  The tubes that pump waste material from the roller waste collector and the

Waste-Pump  purge unit should be replaced after 1500 hours of printing. At this time, a

Tubes counter should display a maintenance message on the printer interface
screen.

| Slice 2020 of 2020 (100.0%)

:. Previous job last slice: 2019 |

Maintenance Required

Figure 6-103 Maintenance message

You can verify that the pump tubes need to be replaced by examining the
waste pump maintenance counters.

To open the Maintenance Counters screen:
> Click on the "Maintenance Required" indicator.
or—

> From the Options menu, select Maintenance Counters.

Go to Tray Upper Position F5

Go to Purge Position F&
Wipe F7
Go To Head Inspection Fa
Go to Tray Lower Position Fl0
Execute Purge Sequence Fd4
Pattern Test F3

Dynamic Mozzle test

Wizards *
Built In Tests... Ctrl+Alt+B

Maintenance Counters.., L\\)
Collect Service Data F2

Figure 6-104 Selecting Maintenance Counters from the Options menu.
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When the Maintenance Counters screen opens, scroll down to the General
Pumps section.

General Pumps

Purge Unit Pump— [2241 [30/e/15 | [3500 Reset I
Fioller ditt Pump 232 [30/0615 | [3500 Reset I
Purge Unit Purtp Tube[7357 [30/06,15 | Jr500 Reset v
Wacwum Purmp [7o34 [30/08/15 | 12000 Reset r
Rialle it Pump Tube [57 [21/0216 | Ji500 Reset v

Figure 6-105 Pump Maintenance Counters
The waste-pump tubes that require replacing are displayed in red.

Note: If the check box on the right is selected, the "Maintenance Required”
indicator appears when that task is due.

To replace pump tubes, you replace the "cassette" assembly that attaches to
the pump in the printer. Replacement cassettes are supplied in the printer
Start-up Kit. Additional cassettes can be ordered from your Stratasys service
provider.

To replace the waste pump tubes:
1. Make sure that the printer is in Idle mode (see Figure 6-3 on page 6-4).
Note: The printer enters Idle mode about 16 minutes after printing stops. To

force the printer into Idle mode, close the printer application: From the File
menu, click Exit.

2. Using an 8 mm hex (Allen) key, open the two latches that secure the left
printer panel (as you face the printer).

b’

Figure 6-106 Opening a panel latch

6-70



Stratasys J750 User Guide 6 Operating and Maintaining the Stratasys J750 3D Printer

3. Open the panel and disconnect the ground (earth) wire.

Figure 6-107 Ground wire connected to panel
4. Remove the panel.

5. Identify the waste pump that requires tube replacement.

M= —Purge-unit waste pump

Roller-waste pump

Figure 6-108 Waste pumps
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6. Unscrew the fittings that connect the waste tubes to the pump.

Figure 6-109 Disconnecting a pump tube
7. Remove the part of the fitting remaining on the pump tube, and save it.

8. When the tubes on both sides of the pump are disconnected, rotate the
pump "cassette" assembly counter-clockwise and remove it.

Figure 6-110 Rotating the pump cassette
9. Install a new pump cassette.
The new cassette contains a new pumping tube.
10. Connect the waste tubes to the new pump cassette.
11. If necessary, replace the pump cassette on the other waste pump.

12. Open the Maintenance Counters screen, scroll down to the General
Pumps section, and click Reset for the relevant counter(s) (see Figure 6-
105 on page 6-70

13. Connect the ground wire to the printer panel and attach the panel to the
printer.
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Replacing the A filter is installed in the line that supplies Vero PureWhite Model material to
Vero the print heads. To ensure that the heads remain in optimum condition, this
PureWhite filter should be replaced periodically. A counter keeps track of the amount of
Material Filter  material passing through the filter, and the Maintenance Required indicator
appears in the printer interface when it is time to replace the filter. The
counter is set for 15 hours—enough, on average, for about a year of printing.
To check the counter, open the Maintenance Counters screen (see
"Maintenance Counters" on page 6-30) and scroll down to the Filters section.

=
Ele Units
Item Total Dated Warmning Time User Warning
Total Frinting tine 2302 ENEE [z
B
Wiper Blade [z0 [zg/0518 | 500 Fresst | ¥
Fiollsr Blade | EEE | B 1000 Reset | ~
Filters
W1 Fine Fiter [o EIE 5 Aeset | M
M2 Fire Filter [o [zzsnE (15 Fresst | ¥
M3 Fine Filter [o EIE 5 Resst | ~
M4 Fine Fier [0 EEN Reset I
M Fine: Fiter [ [pzosne 5 |1 Rest =
ME Fitte Filter [a [zzi0516 |15 Reset | ¥
General Pumps
Purge Unit Pump — [230 [zsens | [am00 Resel | L
Raller dirt Pump [2454 00815 3500 Rresst | r
Purge Unit Pump Tubef15 J17/m5/16 1500 Reset | ~
Raller Dirt Pump Tube IQSE; |2‘I 0246 |15|3EI Rezet | il
Print Heads
|

i Close Save |

Figure 6-111 Maintenance Counters screen, showing material filter
The figure above shows that five hours of filter time have passed since the
filter was installed in the M5 slot location.

%( The factory-installed filter for Vero PureWhite is in the M5 slot location.

To replace the material filter:

1. Prepare the following tools and materials:

O 8 mm hex (Allen) key

O protective gloves

O cleaning cloths or paper towels

O replacement filter (supplied in the Start-up kit)
2. Close the printer application.
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3. Shut down the printer computer, wait 60 seconds after the monitor goes
blank, and turn off the main power switch.

& Caution:

The monitor goes blank as soon as the remote desktop link terminates—
before computer shutdown. Turning off the printer before computer shutdown
can cause damage.

4. Using an 8 mm hex (Allen) key, open the two latches that secure the back
of the materials cabinet and remove the back of the cabinet.

5. Locate the Vero PureWhite filter.

Figure 6-112 Material filter for Vero PureWhite

6. Put on protective gloves.

Warning: Toxic and Corrosive Materials

Prolonged contact with resins could cause skin irritation. Put on protective
gloves before continuing.

7. Disconnect the tube connected to the left (inlet) side of the material filter.

Important:

To disconnect the feed tube, hold the fitting at the end of the tube in place and
turn the filter. Otherwise, the feed tube will be twisted and material might leak.

8. Make sure that the fitting at the end of the feed-tube remains attached to
the tube. Re-attach it, if necessary.

9. Cover the filter with a cleaning cloth (or paper towels) to absorb material
spillage.
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Replacing the
Odor Filter

DOC-08040 Rev. A

10.0n the new filter, identify the side marked INLET.

Figure 6-113 Inlet side
11. Attach the inlet side of the new filter to the disconnected tube.

Important:

To attach the filter, hold the fitting at the end of the feed tube in place and turn
the filter. Otherwise, the tube will be twisted and material might leak.

12. Disconnect the old filter from the other (right) tube.
13. Discard the old filter.

Caution:

The filter contains uncured printing material. Discard the filter in accordance
with applicable environmental regulations.

14. Attach the disconnected tube to the new filter.

Important:

To attach the filter, hold the fitting at the end of the feed tube in place and turn
the filter. Otherwise, the tube will be twisted and material might leak.

15. Wipe the filters, tubes and surrounding area to remove material leaks and
spills.

16. Replace the back of the materials cabinet.

17. In the Maintenance Counters screen, click Reset and then Close (see
Figure 6-111 on page 6-73).

If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (as necessary) to keep your working
environment pleasant.
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Replacingthe  The UV lamps used for curing models have a long, but limited, working life.

UV Lamps You can test and adjust their effective power with the UV Calibration wizard
(see "Testing and Calibrating the UV Lamps" on page 6-61). If you need to
replace a UV lamp, follow these instructions:

1. Make sure the printer is in offline mode.

Figure 6-114 Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

Warning

Before continuing, make sure that the safety interlock is not defeated, and that
the UV lamp is not hot.

2. Start the UV Lamp Replacement wizard from the Options menu (see
"Starting the Wiper Cleaning wizard" on page 1).

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

-

-
UV Lamp Replacement Wizard

A Check Printer
?Q;;j "-':[—l Confirm before continuing:
kk‘ {4 7 [ The build tray is empty.

stratasys

| x Lancel |

L

Figure 6-115 “Empty tray” confirmation screen
The axes move to the “home” position.
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4. Select the UV lamp(s) to be replaced and click Next.

-
UV Lamp Replacement Wizard

Select Action

|| Replace the right LY lamp.
[~ Replace the left % lamp.

stratasys

x Lancel " Ereviou:

L

Figure 6-116 UV lamp selection screen

5. Disconnect the UV-lamp power connector and the UV heat fuse
connector.

UV Heat Fuse

Conneclor

UV Lamp
Conneclor

Figure 6-117 Disconnecting the UV lamp

Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover up
(B), then out (C).

Figure 6-118 Removing the UV lamp cover
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7.

0.

Pull the UV lamp reflector out of the UV housing.

Figure 6-119 Removing the UV lamp reflector

Inspect the new UV lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the reflector
opposite (not next to) the print block.

Note: Extra black strips are included in the printer Start-Up Kit. If necessary,
you can remove the black strip from the old reflector and install it in the new
reflector (as long as the black paint has not faded).

Discard the old UV reflector and lamp.

%{ Dispose of the used UV lamp in accordance with environmental and safety
requirements.

DOC-08040 Rev. A

Warning: Broken UV lamp hazard
UV lamps contain mercury. Deal with broken lamps with caution.

Ventilate the room thoroughly.

Use protective gloves when collecting mercury and lamp components.
Remove spilled mercury with a method that prevents the generation of
mercury vapor, such as a syringe, packing tape or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container.
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10. Insert the new UV lamp/reflector unit into the housing next to the print
block.

Wilamp | ,_ UV lamp
assembly —— assembly
Black sfrip Black strip

Figure 6-120 Print block and UV lamp assembly, showing correct
placement of black strip

11. Replace the UV lamp cover by inserting it into the slot on the bottom of
the housing, and tighten the securing screw on top.

I:!EI
Figure 6-121 Replacing the UV lamp cover
12. Reconnect the power and heat fuse connectors.

UV Heat Fuse
Conneclor

U Lamp
Cofineclor

Figure 6-122 Connecting the UV lamp
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13. In the wizard screen, confirm that you have replaced the UV lamp(s) and
that the black strip is attached, then click Next.

-
UV Lamp Replacement Wizard

Restore Printer

Confirm before continuing:

[ The selected LY lamps were replaced.

[ The black strip iz positioned comectly (see Help).

stratasys

| 2 Help | X Cancel |

L

Figure 6-123 UV-installation confirmation screen

The wizard operates the UV lamps and checks if their power is within the
acceptable range for each printing mode.

Note: The mode currently being checked appears in the lower-left corner of
the printer interface.

-
UV Lamp Replacement Wizard

Warming UV Lamps

Gﬁ LY lampis) warming up. This takes about 4 minutes,

stratasys

| x Lancel |

L

Figure 6-124 Status screen during UV lamp check
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After replacing a UV lamp, it is recommended that you calibrate its power
for the various printing modes. The next screen allows you to continue to
the UV Calibration wizard (see "Testing and Calibrating the UV Lamps" on
page 6-61).

UV Lamp Replacement Wizard

Select Action

@ Run the LY Calibration Wizard now,

171 End the wizard.

stratasys

[

Figure 6-125 Wizard continuation screen
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Built-in Tests  The printer application contains a suite of tests for regularly checking the
hardware and software, and for troubleshooting. You can configure basic
communications and environment tests to run automatically, when the J750
application opens. In addition, you can run a more comprehensive set of tests
before processing a print job, as a system check, to ensure optimum printing
results.

Because running the tests affects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing,.
The test suite features:

 The organization of printing-related tasks in categories:
O Communications

O Data cards
Temperatures
Voltages

Encoder repeatability

aaaaq

Print-head heating
O Print-head filling

« A clear display of test results and the source of any failures, enabling you
to determine if printing is possible or worthwhile.

« The ability to monitor test results for specific components.

« Troubleshooting tips.

Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you of
possible printing problems, either for current or future jobs.

QE{ Stratasys recommends running the built-in tests in the following cases:

« as aroutine test, once every two weeks
« as asystem check, before major (long) jobs
« as needed, for troubleshooting
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Accessing
Built-in Tests To open the Built-in Tests screen, do one of the following:

» From the Options menu, select Built-In Tests.
* Press Ctrl+Alt+B.

File Optionhs
._| Go to Tray Upper Position F5
Str:. Go to Purge Position Fi&
Wipe FZ
Go To Head Inspection F&
\[ Go to Tray Lower Position F10
Purge Sequence F4
| Pattern Test F3
k[ Wizards k
BuiltIn Tests.., Ctri+AR+E B
\ Maintenance Counters...
| | Collect Service Data F2

Figure 6-126 Selecting Built-In Tests from the Options menu

The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are

displayed.
.
Built In Tests
Test Narme Group Status  Error Description =
O FIFO Norentermupt Test Data Card ?
O FIFD Interrupt Test D ata Card ?
O Swstem Info Erwvironment ?
[ Paramemeter Sanity Check Pararmeters ?
OFRFID RFID K
O Sub-Sypstem Commurications Commuicat... ? L
[ Cabin Temperature General ? 3
[0 Head EEPROMs Head Cards 9
[ Head Valtages Head Cards ?
[ Head/Black Heaters Heaters ? Summary
O 5vstem Yoltages Syztem Yol ? ?
O Interlock Interlock ?
O Uv Lamps Lamps ? =
[ Ases Limits Moteors ?
[ Elock Filling Filling ? o
e i - - 5 - i +h
4 | [T | 3
Teszts Selection —
Group Selection Set ‘“ﬁ Help
[ All | | Moaone | [Unknnwn| [--None - vl [--None - vl =
3 Close

LS

Figure 6-127 Built In Tests screen
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Test List Test Name

This column lists all of the tests, together with selection check boxes.

Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group drop-down list at the bottom of the
screen.

Group
This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
drop-down list at the bottom of the screen.

Status

This column shows the results of each test after you run it:

v’ Test successfully completed.
X Test failed.

? Unknown results. (The test has not been run yet.)

Test Selection Area

In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.

None Click to de-select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).

Group Use this menu to select tests by component category.

Selection Set | Use this menu to select a pre-configured set of tests to run at
specified times (computer startup, before printing, etc.).

Running Built-in To run the selected tests:
Tests

> Click |

After you run a test, the Save and View command buttons are added to the
Built In Tests screen.
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Test Results

Command
Buttons

Summary

X

‘-48 Help
9% Close |

Summary

DOC-08040 Rev. A

To save and view a report of all tests:

> Use the Save and View command buttons.

You click the command buttons, on the right side of the screen, to perform
the following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to
Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as an
HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files are
saved in the J750 installation folder, but you can save it in any other folder.

View

Click to display the latest test report that you saved. (You can view other test
reports by opening the relevant files in your Web browser. To do so, open
Windows Explorer, and double click the BITReport file.)

Close

Click to close the Built-in Tests screen.

On the right side of the screen, a symbol represents the combined results of
all the tests run, using the symbols from the Status column.

v All tests successfully completed.
X At least one test failed.
? Not all tests performed.
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o Test The following table lists the name of each test in the Built-in Tests suite,
Descriptions gnd together with its description and a possible reason for its failure. If you need
Troubleshooting assistance, contact your Stratasys service provider.

Test Name

Description

Possible Reason for Failure

Sub-System
Communication

Tests communications between
components.

* Disconnected communications
cable.

+ Faulty cable.

FIFO Non-Interrupt/
FIFO Interrupt

» Tests the data queue in the
DATA PCI card.

+ Tests the Windows interrupt.

+ If both FIFO tests fail:
Faulty DATA_PCI card.

+ If only the FIFO Interrupt test fails:
Faulty Windows interrupt.

Encoder Tests the encoder's reliability by Faulty encoder.
comparing readings from multiple
runs along the X-axis.
System Info Compares the following parameter | Failure of RAM memory allocation in
values with the minimum the printer computer.
requirements.
+ physical memory
* available memory
+ free space on disk
* monitor resolution
RFID Verifies the presence of RFID tags + Faulty RFID reader.
on all loaded material cartridges, and | Faulty RFID reader power supply.
tests them by writing to and reading I
+ Faulty or misaligned RFID tag.
from each one. ] . )
» High level of electromagnetic noise
around the RFID tag.
System Voltages Checks if the following voltages are | « VPP power supply:
within 5% of the required voltage: Faulty head drive(s).
* 40V to the print heads by the VPP| * VDD power supply:
power supply Faulty height thermistor(s).
* 12V to the height thermistors by
the VDD power supply
Block Filling Analyzes the thermistor readings Faulty thermistor.
when the block is full and when it is
empty.
Interlock Tests the interlock in the printer « Failure of interlock mechanism.

cover.

+ Faulty latch.
* Disconnected cable.

Cabin Temperature

Tests the temperature level in the
build-tray area.

Faulty temperature sensor (OHDB).

Head EEPROM Tests the read/write capabilities of | Faulty print-head driver card(s).
the print-head driver cards.
Head Voltage Checks the control of voltages Faulty print-head driver card(s).

supplied to the print heads.

DOC-08040 Rev. A
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Test Name Description Possible Reason for Failure
Head/Block Heaters | Tests the heaters in the print heads | Faulty heaters or thermistors.
and in the print-block body.
UV Lamps Tests each UV lamp at the High Faulty UV lamp.
Quality power level.
Faulty UV power supply.
Disconnected UV cable.
Axes Limit Tests the hardware and software Faulty hardware sensors.
limits of all axes. Wrong Max Position parameter.
Parameter Sanity Compares the values of all printer One or more of the printer parameters
Check parameters (in cfg files) to the is not within the required range.
required values. Details appear in the BIT report.
Vacuum Tests the vacuum level in the print « Faulty vacuum sensor.
block. + Vacuum leakage.
* Wrong parameters.

DOC-08040 Rev. A
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Replacing the  printer waste contains partially cured polymeric material, collected during

WaSte_ normal operation and maintenance of the printer. For safety and
Container environmental reasons, this material is kept in a special leak-proof, disposable
container.

The container has a capacity of 10 kilograms of waste material—usually
enough for several months of printer use. The printer application displays a
warning message when there are 9 kilograms of material in the container,
and stops the printing when the net weight reaches 9.5 kilograms. Above 9
kilograms, the software does not allow you to start a printing job or activity
until you replace the waste container. You can monitor the weight of the
waste container in the Maintenance screen of the printer interface. You can
also visually inspect the level of waste in the container. To access it, see page
6-89.

To monitor the waste weight (and other indicators) in the printer:

> In the main printer interface screen, click the display toggle to view the
printer indicators.

itenance Help
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Waste weight—

Display toggle [~
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Figure 6-128 Printer interface, showing waste weight (red background
indicates operator alert)
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The waste container consists of a plastic container inside a cardboard box.
You typically dispose of the entire waste container—including the box.
Therefore, you must assemble a new box and insert a new plastic container
before you can install it in the printer.

Replacement boxes, plastic containers, and sealing caps are supplied in the
J750 printer start-up kit and in the preventive-maintenance kit.

To prepare a new waste container:

1.

Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Place a new plastic container into the box.

Note: Do not close the box until you connect the waste drain tube from the
printer.

To replace the waste container:

1.

Locate the door on the lower-left side of the printer.

2. Push in the top-center of the door to release the latch and open the door.

5.
6.

Figure 6-129 Accessing the waste container

Carefully slide out the waste container to remove it from the printer.

Close the full container with the cap supplied with the new waste
container.

Close the new waste-container box, using tape to hold it closed.

Close the waste compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.

DOC-08040 Rev. A
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Cleaning the
Exterior Panels

DOC-08040 Rev. A

The painted exterior plastic panels of J750 3D printers have a durable finish,
offering excellent chemical resistance to common cleaning materials. Follow
the recommendations below when cleaning these areas of the printer.

Acceptable Cleaning Agents
« mild soap solution
« common household cleaners and window cleaners
« common commercial and industrial detergents, 5% solution in water
« alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Unacceptable Materials

« industrial solvents

« cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

« spray disinfectants
« abrasives and agents which could wear away the panel finish
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Removing Models After Printing

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on the
printer, it is best to let the printed models cool in the printer, with the cover
closed, as long as possible.

If the printer must be used to produce additional models as soon as possible:
1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or spatula
(supplied in the tool kit), taking care not to pry or bend the model.

& Warning:

Wear protective gloves when handling printed models before they are
washed.

3. Place the models on a flat surface, and cover them with a cardboard box
or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

After printed models have cooled, the support material must be removed. This
can be done by different methods, depending on the type of support material,
the size of the model, how delicate it is, the amount and location of the
support material, and other factors. Use the following methods as a guide, and
adapt them (or a combination of them) for finishing the models you are
handling.

There are two types of support material available:
« SUP705 (FullCure705), a gel-like support material.
« SUP706, an easily removed support material that dissolves in a solution of
caustic soda and sodium metasilicate.
SUP705 (FullCure705) and SUP706 can be removed from printed models
using the following methods, in this order:
1. by hand
2. water pressure (in a suitable cleaning unit)
3. SUP705: 1% caustic soda solution (recommended for a smooth finish)
SUP706: 2% caustic soda and sodium metasilicate solution

Removing While wearing protective gloves, break away excess support material on the

Excess Support
Material by
Hand

DOC-08040 Rev. A

outside of the model. For delicate models, use a toothpick, pin or small brush
after dipping the model in water.
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« For SUP705, after breaking away excess support material, soak the model
in a 1% caustic soda solution (see "Removing SUP705 with Caustic Soda"
on page 7-3).

« For SUP706, after breaking away excess support material, soak the model
in a 2% caustic soda and sodium metasilicate solution (see "Removing
SUP706 with Caustic Soda and Sodium Metasilicate" on the next page).

Removin_g For most models, the most efficient way to remove support material is by
SUPPOVF Material ysing a high-pressure water jet. One suitable system is the Balco WaterJet
with Water cleaning unit. This device is marketed by Stratasys.

Pressure

%

Removing
SUP705 with
Caustic Soda

| &I
r

i- - & & 0O

Ir_gg_-_:-;i s Light O - II
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| |

| |' | <l = i|‘
[ — 4 |

¥ o |

Figure 7-1 Balco WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump turns
ordinary tap water into a high-pressure jet, and a wiper keeps the window

clear.

Use caution when cleaning delicate models with high-pressure water
systems.

Soak models in a 1-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the model a
smooth, clean finish. The amount of time you soak the model in the solution
depends on how delicate it is and how much support material needs to be
removed, but it is typically between half-an-hour and several hours. In any
case, you should remove as much support material as possible before the
caustic soda treatment, and rinse the model thoroughly (with a water jet)

afterwards.

& Warning

DOC-08040 Rev. A

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into caustic soda. When diluting the solution, always add caustic soda to
water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and models soaked in it.
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Removir?g Soak models in a 2-percent solution of caustic soda (sodium hydroxide) and
SUP706 with sodim metasilicate (NaQSiOB) to remove support material. The amount of time

C::j tISC o?j(i)udrﬁ you soak the model in the solution depends on how delicate it is and how
Metasilicate much support material needs to be removed. Rinse the model thoroughly
under running water afterwards.

%{ SUP706 will dissolve into the caustic soda and sodium metasilicate solution
and saturate it, reducing its effectiveness. Replace the solution when the
Support material reaches 15% of the solution (after approximately one month
of average use).

& Warning

Caustic soda may cause chemical burns, scarring and blindness. Mixing it
with water generates heat that could ignite other materials. Never pour water
into caustic soda. When diluting the solution, always add caustic soda to
water. Take adequate safety precautions; always use nitrile gloves when
handling caustic soda and models soaked in it.

Post-Printing Treatment for Models Made with VeroClear

Models made with VeroClear (RGD810) have a slight yellow tint when
removed from the printer. This is especially true for models printed with a
glossy finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.

As a rule, best clarity is achieved when parts are printed with a matte finish,
and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

— [

o

Figure 7-2  Left: lllumination chamber; Right: Desk lamps
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Photo-
Bleaching
Instructions

Follow these instructions for photobleaching printed models.

« The fluorescent lamps should be rated 45W, 6500K.

» When using desk lamps, place the models in a container lined with

aluminum foil. Use at least two lamps, more when treating models in a
large container.

« Arrange the models with enough space between them to allow light to
reach all sides of each model.

« Verify that the ambient temperature around the models is approximately
40°C (104°F). Higher temperatures may cause model distortion; lower
temperatures may not produce satisfactory results. When using desk
lamps, you can achieve the required temperature by positioning the lamps
approximately 10 cm (4 in.) above the models.

« Inspect the models after six hours of treatment.

O For parts with a matte finish, this should be enough. Polish and
lacquer the parts.

O For parts with a glossy finish, continue the photobleaching treatment
for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately 70%
within six hours. After 24 hours, tint was reduced by approximately 90%.

More information about this treatment is available in the application note
VeroClear RGD810 Model Material.

Storing Models

DOC-08040 Rev. A

Models are cured as they are printed, making them safe and stable for a long
time. However, proper storage conditions are necessary to prevent deforming.

« Keep printed models at room temperature and in a low-humidity
environment.

«» Do not expose models to direct sunlight and other heat sources.
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